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Introduction to this tutorial

You can use the IBM® WebFacing Tool to create Web front ends to iSeries™
applications that use DDS for their green-screen transactions. You choose a Web
style for your green-screen application, generate a set of JSP and XML files that
interact with the logic of your program, and then easily test your application in the
WebSphere® test environment of the workbench. When you are ready to deploy
your application, you can generate standard J2EE WAR and EAR files that can be
installed on a WebSphere Application Server.

The WebFacing Tool is ideal for applications that you want to deploy broadly over
a corporate Intranet or the Internet, where rapid deployment takes precedence over
customizing the look and feel of each page. With the WebFacing Tool you can
continue to deliver your application as a 5250 application, and use the same ILE
and non-ILE programs to deliver the application through the Web. Note that there
are some restrictions, described in the WebFacing documentation, on which DDS
keywords can be converted to generate sets of JSP and XML files.

CODE Designer has been enhanced to work with the WebFacing Tool. A new Web
Settings section helps you specify how your DDS fields will be handled by a
browser after they are converted using the WebFacing Tool, without affecting their
appearance on the green-screen.

Tutorial purpose:
Before you begin, take a minute to read the learning objectives for the
tutorial.

Length of time:
This tutorial takes approximately 1.5 hours to complete.

Modules:
Work on the modules in sequence. The pictures in the modules show
similar tasks. Some of the names and icons may be different from the
environment you will be working with when you complete the modules.

Prerequisites
You should also learn about the prerequisite knowledge for the tutorial
before beginning. This section describes the type of knowledge you need to
already have to fully benefit from this tutorial.

Learning objectives

In order to successfully convert existing DDS screens in a green-screen application
to a Web browser user interface, you will need to understand many concepts. This
tutorial is designed to help you learn about those concepts while working through
the steps.

In this tutorial, you will convert the DDS screens in an existing 5250 order entry
application to a Web browser user interface. While creating a browser user
interface, you will learn how to use the IBM WebFacing tool. You will also learn
how to customize the output of the conversion process using the IBM WebFacing
tool and the CODE Designer. Finally, you will learn how to run the WebFacing
application in the WebSphere Test Environment that is part of Development Studio
Client.

© Copyright IBM Corp. 2001, 2004 v
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The tutorial is broken into eleven modules, each with their own specific learning
objectives. You can choose to complete all modules, or you can choose to complete
only a few, depending on your own learning goals. Each module is composed of
several exercises. These exercises must be completed in order to successfully
achieve the module’s goals.

The first module, Reviewing the 5250 application, helps you learn about the 5250
order entry application before you start and use the WebFacing tool to convert it.
This allows you to become familiar with the 5250 screens and the behavior of the
application. After the conversion with the WebFacing tool you can then easily
compare the 5250 and the Web user interface.

The second module, Creating a WebFacing project explains that before you can use
the WebFacing tool to reface your application you need to create a WebFacing
project. You will also learn that this project is a complete Web project with the
directory structure and files needed to conform to the Java" 2 platform, Enterprise
Edition (J2EE) standard of a Web application and it also contains additional
information unique to WebFacing like the source to be converted and runtime
information.

The third module, Converting selected source members, helps you learn about the
conversion option, how to select one or multiple files for conversion and how to
work with the conversion logs to check the results of the WebFacing conversion.

The fourth module, Running the Web application explains how to run the Web
application in the WebSphere Test Environment. You also learn about the
WebSphere Test Environment. You see the results of the conversion results and
have the opportunity to try the converted interface like you did in module 1.

The fifth module, Changing the user interface, you learn how to change certain
aspects of the user interface related to the conversion process.

The sixth module, Changing the style of the Web user interface, you learn how to
create a new style, change style settings, specify the new style to be used for the
project and refresh the project with the new style.

The seventh module, Adding command key rules and labels, explains how to add
your own command key recognition rules to the WebFacing conversion properties.
You will also learn how to add command key labels that have missing labels in the
DDS source.

The eighth module, Working with more style properties, you learn how to apply
changes to windows, the look of push buttons, and subfiles.

The ninth module, Adding authentication, explains how to secure your application
by forcing authentication before the application is called.

The tenth module, Enhancing the input page using Web tools, explains how to take
the plain index.html page generated by the WebFacing tool and add color and
some pictures to make the input page of the Web application more interesting. You
will learn how to use the Page Designer tool and some other related Web tools.

The eleventh module, Exporting to iSeries WebSphere Application Server Express
5.0, describes how to export files created by the WebFacing Tool to a remote
WebSphere Application Server, to publish and deploy your application as you
would when your application is ready for production.
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Be sure to read about the Prerequisite knowledge for the tutorial before beginning.
This section describes the type of knowledge you need to already have to fully
benefit from this tutorial.

Prerequisite knowledge

In order to complete this tutorial end to end, you should already have working
knowledge of the following:

* Basic Microsoft® Windows® operations such as working with the desktop and
basic mouse operations such as opening folders and performing drag-and-drop
operations

¢ How Web applications work

* How to use a browser to navigate the Internet

It is also useful, but not necessary, for you to have basic knowledge of the
following:

* DDS

* Servlets and Java Server Pages (to understand the generated output of the
WebFacing tool)

If you do not have current knowledge of these technologies and concepts, you
might be interested in learning more about these after you complete this tutorial.
You can find some additional information on these topics in the Help system that
is part of WebSphere Development Studio Client for iSeries. There are also plenty
of resources on the Internet at our product Web page

http:/ /ibm.com/adwtools/iseries.

In the next module, you use a 5250 emulation screen to start the sample Order
Entry application. In this application you will be prompted with the first screen for
a customer number. You will work with the help panels this application provides.
You will select a customer from a list of valid customers and then go through the
steps of filling an order by specifying the quantity ordered. After all parts and
their quantities for this order have been specified you complete the order by
pressing a specific command key. The application will then prompt you for a new
customer number to handle the next order.

When you are ready to begin, start with the first module.

Introduction to this tutorial Vi1
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Chapter 1. Reviewing the 5250 order entry application

In this module, you are going to explore the application by invoking it from a 5250
session and working with the applications green screens and command keys. This
will also test your user profile setup. If you can run this application directly
without changing the job environment on the iSeries, the WebFacing conversion
and the WebFacing server will not have problems during the remaining exercises
later.

Note: If you have problems make sure the library list for your job is setup
correctly to include library WFLABXX at job start up.

You will learn about the 5250 application, before you start to use the WebFacing
tool to convert it. This will allow you to become familiar with the 5250 screens and
the behavior of the application. After the conversion with WebFacing tool you will
then be able to compare the 5250 and the Web user interface.

Remember: Before beginning this module, you should learn about the Prerequisite
knowledge for the tutorial.

In order to review the 5250 order entry application, there are several steps you will
need to learn about and follow:

e Starting the 5250 application
* Knowing what screens the application provides
* Knowing how the application works in its 5250 environment

* Knowing what command keys are supported and what functions they allow

In order to accomplish these learning objectives, there are several steps that are
involved, including:

e Starting the 5250 application
* Accessing the online help

* Selecting a customer

* Filling the order

* Completing the order

The exercises in this module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 5 minutes to complete.

Starting the 5250 application

You need a 5250 emulator on your workstation to start the order entry application.
To start the 5250 application:
1. Start a 5250 emulation session.

2. In the User ID field, type your user ID.
3. In the Password field, type your password.

© Copyright IBM Corp. 2001, 2004 1



4. On the command line of the 5250 screen, add the library WFLABXX to your
library list:
ADDLIBLE WFLABXX
5. Invoke the Order Entry Application:
CALL ORDENTR
The application starts and shows the first panel. This first screen prompts for a

customer number. You have a choice of keying in the customer number directly
or you can press command key 4 to display a list of existing customers.

& 1 Session A - [24 % 80] _ =10f x|

Eile Edit W¥iew Communication Actions ‘Window Help

JM@I@!@J'@I&IMJQ@I

Farts Order Entry

' | i :Cc-nnected to remote serverf/host toras pd101 on psprintl:pd101

Accessing the online help

Before you go ahead with the order entry process, try the help. This application
uses User Interface Manager (UIM) help. You will also convert these UIM help
panels with the WebFacing tool. To understand the results of the UIM help
conversion, try the help in the 5250 environment and then later in the browser.

1. Move the cursor to the Customer number field.
2. Press command key 1.

Panel group help displays for the customer number:

e 1 Session A - [24 x 80] =10 x|

File Edit WYiew Communication Actions W|nl:|c|w Help

JM@EMJ'@I&IMJQ@I

Farts Order Entry

| i ch-nnected to remote serverfhost toras pd101 on psprintl:pd101
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3. To see more help, move the cursor underneath the 1 in the help area and press
the Enter key.

Help for requesting a customer list displays:

e 1 Session A - [24 x 80] =10 x|

Eile Edit W¥iew Communication Actions ‘Window Help

B DD 2% Em @6 % el & @l

er Entry

)" [Connected to remote serverfhaost toras pd101 on psprintl:pd101

4. Press command key 12 to return to the help for the Customer number field.

5. To see help for the second choice, move the cursor underneath the 2 in the help
area and press the Enter key.

Now you see detailed help for specifying a valid customer number:

e 1 Session A - [24 x 80] =10 x|

Eile Edit W¥iew Communication Actions ‘Window Help

D] 2% B w| % & 8] @

irder Entry

Eottom

| i ch-nnected ko remote server/host toras pd101 on psprintl:pd101

6. Press command key 12 to leave the help for the Customer number field.
The main help panel in the Select customer — Help area shows.
7. Press command key 2 to get to the extended help.

Chapter 1. Reviewing the 5250 order entry application 3



Here you see the extended help for the Customer number field:

e 1 Session A - [24 x 80] =10 x|

Eile Edit W¥iew Communication Actions ‘Window Help
D 2 @ b % & 3] @

“12=Information Assi

' | i :Cc-nnected to remote serverfhost toras pd101 on psprintl:pd101

8. Press command key 12 to leave the extended help for the Customer number
field.

9. Press command key 12 again to leave the help for the Customer number field.

Selecting a customer

Now you have an understanding how the help panels in this application work and
look. Next you need to identify the customer related order. You have the choice of
specifying a valid customer number, or you can get a selection list of valid
customers. Use the selection list to because it uses the WINDOW DDS keyword
and so you can see how the WebFacing tool converts a DDS window.

1. Press command key 4 to display the customer selection list.

A list of customers displays:

e 1 Session A - [24 x 80] =10 x|

File Edit Wiew Communication Actions ‘Window Help

B B 2% BlE 8] %) 2 3| @l

Farts Order Entry

F4=Prampt F

' | i :Cc-nnected to remote server/host toras pd101 on psprintl:pd101

2. In the Options field, type 1 to select a customer.
3. Press the Enter key to proceed.
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This returns you to the initial panel now filled with detailed data for the
selected customer.

e 1 Session A - [24 x 80] =10 x|

File Edit Wiew Communication Actions ‘Window Help

D] 2% B w| % & &) @

irder Entry

Fa4=Prompt FE

Gl :Cmnected to remote server/host toras pd101 on psprintl:pd101

You'll notice that an order number has been assigned as well. You are ready to
order some parts.

Filling the order

The process of selecting parts is similar to the way you selected a customer in the
previous exercise. You are able to key in the part number directly or select the part
from a selection list. Next you want to work with the parts selection list.

On the order entry panel:
1. Press command key 4 to see a list of available parts.
The Select Part panel opens:

e 1 Session A - [24 x 80] =10 x|

File Edit Wiew Communication Actions ‘Window Help

B B 2% BlE 8] %) 2 3| @l

Farts Order Entry

' | i :Cc-nnected ko remote serverf/host toras pd101 on psprintl:pd101

2. In the Options field, type 1 next to a part that has lots of quantity left.
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Back on the order screen, the part appears in the order; on the top line of the
parts list:

& I Session A - [24 x 80] ) =10l x|

File Edit Wiew Communication Actions ‘Window Help

B DD 2% EE) w8 % e & el

Farts Order Entry

F4=Prampt F

| i :Cc-nnected to remote serverfhost toras pd101 on psprintl:pd101

Next you order a certain quantity of this part.
3. Change the Qty field to a value, for example 2.
4. Press the Enter key to add the part and quantity ordered to the order.

The detail order line for this part, with the quantity specified, is now part of
this order:

e 1 Session A - [24 x 80] =10 x|

File Edit Wiew Communication Actions ‘Window Help
B DD 2% G @6 b 9| @2

Farts Order Entry

Ecttom

F=Exit F4=Prompt

i | i :Cmnected to remote serverf/host toras pd101 on psprintl:pd101

Add more parts until your order is complete.
5. Press command key 4 to see a list of available parts.
6. Select a part from the parts list and press Enter.
7. Specify the part quantity and press Enter.
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Completing the order

Now you are ready to accept the order. You use the Order Entry panel to complete
the order.

To complete the order:
1. Press command key 6 to accept the order.

The order is added to the database and the next order can be filled. You return
to the starting screen of the application.

You have worked with all panels in this application:
* The start order entry panel
* Several help panels
* The customer list window
* The full order entry panel
* The parts list window
You can add more orders but if you understand how the user interface of this
application works, stop adding orders.
2. Press command key 3 to exit the application.

You are now ready to put a brand new user interface onto this application.

Recap

Congratulations! You have completed this module. You should now understand
how to:

* Start the order entry application

 Use the help panels in this application

* Select a customer from the customer selection window
* Select parts from the parts selection window

¢ Order a certain quantity of parts for the order

* Complete the order

* Exit the application

Before you can use the WebFacing tool to reface your application you need to
create a WebFacing project in the Development Studio Client workbench. The first
step when starting with the WebFacing tool is to create a WebFacing project You
will identify the project information, like the DDS source member names to be
WebFaced, and they will be stored in a workspace on your workstation. This
exercise guides you through the process of identifying the DDS and Panel Group
source members to be converted by the WebFacing tool. It also goes through
specifying some of the runtime information you will need later when running the
WebFaced application.

You have reviewed all the panels in the order entry application. Continue to the
next module.

Chapter 1. Reviewing the 5250 order entry application 7
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Chapter 2. Creating the WebFacing project

In this module, you will learn how to create a WebFacing project, something that
you need before you can create a Web user interface for the Order Entry
Application. You will then learn how to use this WebFacing project to facilitate the
conversion of your DDS source and to test the generated output.

A WebFacing project is a complete Web project with the directory structure and
files needed to conform to the Java 2 platform, Enterprise Edition (J2EE) standard
of a Web application. It also contains additional information unique to WebFacing,
like the source to be converted.

In order to create the WebFacing project, there are several steps you will need to
learn about and follow:

¢ Understanding the workspace

* Understanding the WebFacing project

* Understanding the WebFacing perspective

¢ Understanding the J2EE settings page

* Starting Development Studio Client workbench
e Starting the WebFacing tool project wizard

* Stepping through the project wizard pages

* Providing the correct input to the project wizard
¢ Browsing through the new WebFacing project

In order to accomplish these learning objectives, there are several steps that are
involved, including:

e Starting Development Studio Client workbench

* Opening the WebFacing perspective

* Starting the WebFacing Project wizard

* Selecting display file source members to convert

* Specifying the CL command to launch the application
* Selecting a Web style

* Completing the WebFacing project information
The exercises in this module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 5 minutes to complete.

Starting Development Studio Client workbench

Now go ahead and start Development Studio Client.

To start Development Studio Client:

© Copyright IBM Corp. 2001, 2004 9



1. On the desktop task bar click Start > All Programs > IBM WebSphere Studio
> Development Studio Client for iSeries 5.1.

[‘g ]ws_FrPProEx gj 1D Workbench &P Development Stud

7] Java 2 Runtime Environment
Starl o Condal Q Lavasoft Ad-aware 6
£ Lotus Applications

E Vicrosoft 7] Lotus SmartSuite

7] Microsoft Office Tools

Epk Edtor }; Metscape Communicator

T Norton AntiVirus Corporste Edition
1 !3 Object REXX for Windows
£ Palm Desktop

!3 QuickTime

All Prograrms

* w W w O w O w w w w w

A dialog appears asking you for the workspace location, unless you used the
Development Studio Client before and selected not to show this dialog again.

The workspace contains all the information about your Development Studio
projects. You can accept the default or store the work related to this tutorial in
a separate workspace. You can always start with a new workspace later, if you
don’t want to mix these exercise WebFacing projects with your real work.

WebSphere Studio x|

WwiebSphere Studio stores wour work in a directory called a workspace. You can change the workspace each time
pou start WebSphere Studio. Specify the directomny to use for this session:

|E:'\.D0c:.rner!s and Settings\wurichiMy Documents\IBMywdschwflabs Browse... |

™ Use this workspace as the default and do not show this dislog box again

2. Accept the default directory structure but change the name of the workspace
directory to the name wfTlabxx.

3. Click OK.
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After a few moments of loading, the workbench opens, and the initial window
of Development Studio Client opens:

cﬁ: Remote System Explorer - Welcome - WebSphere Developm
Fil= Edit Mavigate Search Project Run Window Help

I J i |J a -F a |J R=BE =R
E Aemet.. tens ¥ X . Xi [OLItIine X
FIEEEE ,

Development St... i
oo =§= fThis page tells you what vou should know befare you; not available.

=10/ x]

An outline is

3 - Developmenk Studio Client Advanced Edition For iSerie ||
E J; U G and click on the related links,
LR wWindows... i
1
[+ Linee, .. —
EI-L%K Ui 3 Get started |
Ta know what to do first, consult the Product Ov |
=B Local.. the inFormation map in the online help to decide F l
LB a iSeties... start using the product. :
#-E Local =
|
{3 Develop iSeries applications |
You can create and maintain RPG and COBOL app ||
Learn more about the Remate System Explorer a |
4 I ;I_I i

8 Remote System Details |=€>E Pl a e x

K JR— |

Remote Systems | Team |

Properties v X

PEX

Property I Value

4| | » | | Remote System Details ]Tasks jiSeries Table View |iSeries Commands Log

Note: If you didn’t reset the workspace, or you are working with the standard
version of Development Studio Client, your environment will differ
slightly from the screen captures in this tutorial.

Opening the WebFacing perspective

The Development Studio Client shows the Remote System Explorer (RSE)
perspective by default. This is the perspective that you would use to work with
iSeries objects. It allows specifying connections to iSeries servers and provides for
the programmer a similar interface to iSeries objects as the Program Development
Manager (PDM) does in a green screen environment.

The WebFacing tool provides it’s own perspective since it needs to give its users
access to unique views and tools targeted towards the WebFacing task. To create a
WebFacing project you first need to open the WebFacing perspective.

To open a WebFacing perspective:

Search Project Run |winduw Help

|Jg |35+ & ~  New Window i::_ B
- M Open Perspective » @Remote System Explorer
I s Shiow View »
v & | H P Hide Editors Other.,..

1. Click Window > Open Perspective > Other from the workbench menu.

Chapter 2. Creating the WebFacing project 11



The Select Perspective dialog opens:

4P Select Perspective

I WJava ZI

St'Java Erowsing

f:"]ava Type Hierarchy

=] Plug-in Development

d} Prafiling and Logaing

%Remote System Explorer {default)
Resource
Server

@ Web

WebFacing

[X] %rL

Sk %5l Debug (=

2. Select WebFacing from the list.
3. Click OK.

The workbench now shows the WebFacing perspective with the WebFacing
Projects view open in the left pane of the workbench.

db webFacing - Welcome - WebSphere Development Studio Client Advanced E ! - |I:I|5]
Fil= Edit Mavigate Search Project Run Window Help

|8-BEe||E%|0]%- ||| AAM||% - -

vebFacil X Weicome x l

Development Studio C...

algt | &

-
This page tells you what you should know befare yvou start deve™]
Development Studio Client Advanced Edition For iSeries, To get
and click on the related links.

3 Get started
To know what to do first, consult the Praduct Overview, Yo
the information map in the online help to decide how you ca__|
start using the product.

3 Develop iSeries applications
‘You can create and maintain RPG and COBOL applications w»
Learn more about the Remate System Explarer and its built:

Remote System Explorer
% To navigate through your iSeries objects, use the power of
The First thing you need to do is create a connection. Once
you can Find and edit vour O5f400 members,

WebFacin, .. JNavIgabor |Server Ca... || 4]

5] Properties IE_.'-’-:D T w x| | &) Thumbnails
Property | value | [anFies **)

el

K

Propartias‘Gallery|5nippets|Wal » Th.rnbnailslstyles |Colors |Links | Servers

You are ready to start the WebFacing project wizard to create a WebFacing
project.
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Starting the WebFacing Project wizard

To start the WebFacing Project wizard:

1. In the WebFacing perspective, click File > New > WebFacing Project from the
workbench menu:

&P WebFacing - Welcome - WebSphere Development Studid
File Edit MNavigate Search Project Run  ‘Window Help
T - ot

Close Crl+F4
Close all Chrl+Shift+F4
Save Ctl+5
“ Save s, .,
i Save Al Chrl4-Shife+5
Revert
Mave...
Rename. ..
Refresh
ol Frint... ChrHP

This will start the WebFacing project wizard.

2. In the WebFacing project wizard you will be presented with the WebFacing
Project page:

# WebFacing Project

- Xl
webFacing Project
Create a ‘WebFacing Project

Project name: | wlabx

Project location: I D:\WorkSpace _WDSCwS1\webFacingTutorialvS 1 ywiab:

Enterprise Application Froject: (' New ( Existing

Mew project name: |wflabx:<EnR

Mew project location: I D:\WorkSpace _WDSCvS1webFacing TuborishyS1\whabxxEAR

Context root; | wflabi:

WebFacing project features:

Enables & run-time architecture based on the Struts 4]

b e framework and imports services for WebFacing projects.
Struts wersion: - See the WebFacing documentation for more information.
[ Generate J5P custom tags

Cancel

3. In the Project name field, type the project name wflabxx.
4. Change the Enterprise Application project name to wflabxxEAR.

Chapter 2. Creating the WebFacing project 13
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This will create a unique Application file for this WebFacing project.

. Leave the default value for the Context root field.

The default value for the context root is the name you provided for your
WebFacing project. The context root is the Web application root, the top-level
directory of your application when it is deployed to a Web server. The context
root can also be used by the links builder to ensure that your links remain
ready to publish as you move and rename files inside your project.

. Leave the Enable Struts support check box selected as you want to create a

project that uses Struts technology.

. Click Next.

The J2EE Settings page opens.

The J2EE Settings page allows you to specify the J2EE level you want the
WebFacing tool to use when creating the files for your WebFacing project. Why
do you want to specify a J2EE level? If you plan to use the WebSphere
Application Server version 5 only then select J2EE level 1.3. If you are using
previous versions of WebSphere Application Server in your environment and
are planning to deploy the WebFaced application to these versions then use
J2EE level 1.2 since these older versions of WebSphere Application Server don’t
support the J2EE level 1.3. In this exercise you will use the WebFaced
application in the WebSphere Test environment, which is version 5, so you will
use J2EE level 1.3.

8. Select 1.3 from the J2EE level list.

# WebFacing Project : ﬁl

JZEE Setting Page
Select the JZEE level for your project, %

Project name: | wilabioe

2EE level !ﬁ

Description:

A WebFacing project created using JZEE Level 1.3 has the Following properties: =]

The target application server is WebSphere Application Server (WAS) version 5. Your application will not work with 'WAS version 4, or
wversion 3,5.6 or higher.

Character encoding of client data is automatically configured. There is no need for manual configuration of WAS to set the character
encoding of client data to UTF-6, Data compression is enabled For Faster page debvery.

The project uses serviet specification 2.3 and 15P specification 1.2,

< Back Mext = Eirnish Cancel

9. Click Next.
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The Select Display File Source Members to Convert page opens:

#WehFacing Project _ ﬁl

Select Display File Source Members To Convert
Select "Refresh DDS kst” to refresh the library kems displayed in the tree, Select members from the tree and add them to the

table for conversion.

Project name: ] whlabuo

Connection: | | mew.., |

Library: [ *LIEL =] Fie: [T > Member: [T =
Member types: |DSPF MNLDDS =l

Click Refresh DDS list buttan , then select files or members and add them to the table for conversion:

Refresh DO list ‘

Library [ File | Member |

< Back Next > Firvistt Cancel

Selecting display file members to convert

On this second page of the WebFacing project wizard you need to specify the
name of the iSeries server that contains your display file DDS source, as well as
which members of the in the source file you want to convert. Specifically, the
WebFacing Tool needs to know these names:

* Server name

¢ Library name

* Source file name

* Member name

Note: You need to identify members for all record formats used in your
application. If you miss one and at runtime the record format gets

requested, your end user will get a Page not found error.

First since you are starting with a new workspace, you need to specify the iSeries
server name to specify where the Data Description Source (DDS) is located,

To connect to an iSeries:
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1. Click New beside the Connection list.

Project name: I wiflaboox

Connection: | !i New... i ’

Library: I"‘I.IBL ;I File: Im ZI Member: Im 'I

Member types: [DSPF MNLIDDS =

Click Refresh DDS list button , then select files or members and add them to the table for conversion: I:

The Name personal profile page opens:

Mame personal profile

Uriquely name user profile ! !

‘Welcome to Remote Systems. Connections can be sharable by the team or private to
you, Enter a profile name to uniquely identify you From your beam members., You will
decide for each new connection whether it is owned by the team profile or vour
profile.

Profile: | YURICH

<gack [ mext> | Eieh | Cancel |

2. Accept the default profile name as this is your own private connection.
3. Click Next.

The Remote iSeries System Connection page opens:

Remote iSeries System Connection

Define connection information ! !

Parent profile: IYURICH 3

Cannection name: | s400a

Host name: I 54003 EI
Description: |
[V Verify host name

<Back wot> |[ Emeh | cancel
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In the Host name field, type the name of the host system, for example s400a.

Note: This is your iSeries server name; don’t use the one shown unless your
system is named S400A.

The connection name will be filled automatically with the same value.

Leave the Verify host name check box selected to verify that the host name or
IP address exists.

Click Finish.
The connection is created and can be re-used by all tools in the workbench.

The connection wizard also checks whether the iSeries host can be reached
and if this test is successfully completed, you return to the Select Display File
Source Members to Convert page.

Check that your iSeries server is selected in the Connection list.

Project name: I wlabnex

Libra(: I"UH- J x| File: I |

s

Make sure that *LIBL is selected in the Library list.
Click Refresh DDS list.

4P webFacing Project

Select Display File Source Members To Convert

Select "Refresh DDS list" to refresh the library items disple
table for conversion,

Project name: | wHabxx

Connection:
Library: | *LIBL ~] Fie: |—

Click Refresh DDS elect files or membe
Refresh DDS list |

., —
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10.

11.
12.
13.
14.

A User ID and password dialog opens:

b Enter Password ..’5.'

System type: I iSeries

Host name: | TORASO7M

User1D: | wdsclaboz

Password: | i

I Permanently change user 1D

| 2|

In the User ID field, type your user ID. Use the same user ID that you used
when running the Order Entry application in Module 1.

In the Password field, type your password.

Select the Permanently change user ID check box.
Select the Save password check box.

Click OK.

A connection to the iSeries server gets established. The library list of your
iSeries job is displayed under the Refresh DDS list button on the Select
Display File Source Members to Convert page.

If you do not see the library WFLABxx in your library list then your job is not
set up correctly to include library WFLABXX at job start up.

Click Refresh DDS list button , then select files or membe

Refresh DDS lisk

FHLL *ALL DSPF MNUDDS

(-0

il Qsvsz

-l QHLPSYS
= QUSRSYS
= il ReELABOZ
-y RSELABOZ
-y, YARLABODZ
G-y, WFLABOZ2 1]

\J =, WsSLAB0Z 4

To select DDS members to convert:

1.

Select the WFLABXX library from the list.
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2. Click the plus sign (+) beside the WFLABXX library to expand it:

# WebFacing Project ' n . ll
Select Display File Source Members To Convert
3 members added For QDDSSRE 5 g

Project name: | wilabix

Connection: |s4IJDa ;I Nawl

Library: Fie: Tl vember
Mesmber types: |DSPF MAUDDS |
Click Refresh DDS list button , then select files or members and add them to the table for conversion:
Refresh DDS st ‘

TORASOTM *LIEL *ALL *ALL DSPF MNUDDS
w1 Qsvs2 -]
-l QHLPSYS AR = 2ICLoID
3 '}-5 QUSRSYS 02 SLTPARTD
[+, RSELABOZ
- i, RSELABOZ
-, vaRLABOZ

= i, WrLABDZ
i .lll 3y H > |
w03 qausre
- =03 qQDDSsrRC
(g4 ORDENTD
(&) SLTCUSTD —
: (& SLTPARTD
| -0 qDDSSRCP
@ L3 QPNLSRC =l

A Anan mren

<Back Hext > fsh | cancel |

3. Select the QDDSSRC source file from the expanded list.

4. Expand QDDSSRC and select all members from the list.

5. Click __>>_| push button in the middle of the page to copy the selected
members over to the list of members to be converted at the right.

Tip: To move all members in a source file you can select the source file icon

itself and click the __>> | push button. This will add all members in a
source file to the list of members to be converted.

6. Click Next to proceed to the next page of the wizard.

The WebFacing Tool now knows which DDS members to convert for this
project. The conversion hasn’t been done but the information is stored for
future use.
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10.

11.

The Select UIM Source Members to Convert page opens:

# WebFacing Project ' . ll
Select UIM Source Members To Convert
1 members added For GPNLSRC 5 g

Project name: | wilabix

Connection: |=4001 x| new.., I

Library: ItLIBL LI File: | LI ity | LI
Click Refresh UIM list button , then select files or members and add them to the table For conversion:
Refresh LIM fist [

TORASO7M *LIEL *ALL *ALL PNLGRP
=il Qsvs

-y Qsvs2

#-Jfl, QHLPSYS

&l QUIRSYS

-, RSELABDZ

& W}, RSELABOZ

-, vARLABOZ

=W, wrLaBZ
N CREEY

=03 Qasre
; (3 qoossre
- £ QDDSSRCP
- =03 QPNLSRC
! (g ORDENTRPNL
- =03 QPNLSRCP
- @03 qreGLESRC bt
| w7 QrPGLESRCP |

WFLAEDZ ORDENTRPMNL

|»

<Back Hext > fsh | cancel |

Now you have to identify the panel group source containing the help
information for the Order Entry application.

Click Refresh UIM list push button.

Expand library WFLABXX.

Select the QPNLSRC source file from the expanded list of library WFLABXX.
Click __>> | push button in the middle of the page to copy all members
over to the list of members to be converted at the right.

There is actually only one panel group member ORDENTRPNL in this source
file.

Click Next to proceed to the next page of the wizard.
The Specify CL Commands page opens.

Specifying the

20

CL command to launch the application

You will now provide the information that will allow the WebFacing wizard to
create the initial index.html page to start the Order Entry application. Do you
remember what you typed on the command line to start the Order Entry
application in the 5250 emulation session during the first exercise in module one?
In case you forgot; it was: CALL ORDENTR

Why should you remember? The WebFacing run time needs to know the
invocation command for your application in order to send this invocation
command to the iSeries server to start your application from the browser. The page
in the WebFacing project wizard will allow you to specify the necessary

ILE RPG WebFacing application



information CL command and Sign on information:

4P WebFacing Project x|
Specify CL Commands
Enter the CL commands that are used in your application, the command labels you want to use, and the signon preference for the
generated hypertext links,

Praject name: I wiflabsoe

WebFacing generates hypertext links that you can use to launch your application From the web. In order to do this, it needs to know the
text that will be shown for each link and the CL command that each link will invoke. On this page you can define multiple links, in case
several CL commands are used to launch your application.

IF your program requires parameters, you can enter them as variables in the CL command, For example: to invoke program MYPGM with a
part number parameter, you would enter CALL MYPGM PARM(&part) as the CL command, The variable "&part” will be replaced when you
chick on the invocation link. For details, refer to the generated index, himl file, The invocation name is used to uniquely identify each
hyperlink in the index.htm file.

" Prompt for signon
gn on with specified values

User [D | WDSCLABDZ

Password | **+Here Confirm password | ke
CL Command I Command Label f Invocation name I User ID |
CALL ORDENTR Order Entry Applica... IN¥1 WDSCLABO2 Delste |

Maove Datwn

< Back @ Finistr Cancel

To specify the CL commands:
1. In the CL command field, type CALL ORDENTR
2. In the Command Label field, type Order Entry Application.

Note: If you don’t type anything into the Command Label field, the command
label input will be copied into this field.

3. Leave the default value INV1 in the Invocation name field.
4. Click the Sign-on with specified values radio button.

This will automatically apply the user ID and password you used when you
connected to your iSeries server in the previous dialog for selecting source
members for invocation of this application. You will use this setup here for
testing purposes to make it easier for you to start the Order Entry application
without specifying the authentication information. Don’t worry about security
in your production environment, this can be easily changed later and you will
see how to do this later in this tutorial.

5. Click Add on the right side of the page.

Note: Make sure the text and command you typed into the fields are actually
shown in the CL Command table at the bottom of the page.

6. Click Next at the bottom of the wizard page.
The Choose a Web Style page opens.
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Selecting a Web style

Next you select a Web style for your converted screens.

To select a Web style:

4P WebFacing Project

Choose a Web Style
Select a "Look and Feel" style to use for the project.

" Enable for Web Site Designer
% Selact classic WebFacing style

Select a predefined or previously customized style:

averus
corporatel
sagel
textbuttans
My Crmpany Loge
3
< Back Mext = Finisty Cancel

1. Select the gradient style from the list of available styles.

2. Click Next.
The Completing WebFacing Project page opens.

Completing the WebFacing project information

On this page you have choice of creating the project and converting the source in
one step or only creating the WebFacing project.
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You will just create the WebFacing project. You don’t need to convert the source
now. Conversion is part of the next module.

4P WebFacing Project

Complete WebFacing Project
‘You have indicated the specifications For your new WebFacing project. To continue, click Finish.

‘You are about to create a WebFacing project.
Da you also want to convert the selected display files?

" Yes, I wank to create the project and proceed with conversion now.

% No. I only wank to create the project now.

To complete the WebFacing project information:

1. Select the No. I only want to create the project now radio button.
2. Click Finish.

The WebFacing project is created. The workbench opens in the WebFacing
perspective with your new WebFacing project in the WebFacing Projects view:

"B ‘WebFacing Projects X

# ﬁ._, wilabc

WebFacing P... | Mavigator | Server Corfi...

Notice that the WebFacing project icon indicates which J2EE level will be used
for the project.

If you expand the wflabxx project you'll notice several files and folders have
been added to this WebFacing project:

¢ The information for display file source members to be converted

* The information for panel group source members to be converted
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¢ The CL Command that will be used to start the Order Entry application
* The style to be used for the converted screens.
View of the new WebFacing project:

=L CL Commands
[ Q Order Entry Application
=& pDs
| <s400a>WFLABDZJQDDSSRC
[+ <5400a=WFLABDZ/QDDSSRC
= <5400a>WFLABO2/QDDSSRE
=L UM Help
#-(3 «5400a>WFLABDZ/QPNLSR.C
-8 Style
=3 5:) gradient
E {=+ apparea
#-E= chrome
B index. html
: @r logon. jsp

4] | i

WebFacing P... | Mavigator | Server Confi...

When you expand the folders and files under your WebFacing project you can
see the information that is captured for this project.

3. Click each folder or file. Click the plus + sign beside each file or folder.
Tip: If you later need to add source members to the WebFacing project,

right-click the DDS or UIM help icon and click Add on the pop-up menu. This
will launch the WebFacing wizard and display the correct dialog.

x
B wiflabixx
- (g CL Commands
- LR
.___.l f
e MNew 3
3 8- style Open
H @ inde:x. hit Open With Pk
@f logon.js| e
DeLte t!
Style 3
Convert
View Log
Properties
KN [ i

Recap
Congratulations! You have completed this module. You should now understand
how to:
* Start Development Studio Client.
* Launch the WebFacing project wizard.

¢ Complete the pages of this wizard in order to create a new WebFacing project
called wflabxx.

* Add to this WebFacing project the following information:
— Which DDS display file source members to use for the WebFacing conversion
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— Which UIM panel group source members to convert

— The CL command which will be used to create the initial index.html page to
start the Order Entry application

— The Web style to be used for the resulting Web pages

¢ Inspect the WebFacing project, to verify that all information entered in the
WebFacing project wizard has been captured.

You have created a WebFacing project in Development Studio Client, in this project
you specified which display file source and panel group source to convert and
which iSeries server these source members are located on. The WebFacing tool will
use this information during the conversion process. You have to specify in this
exercise whether you want to convert all source members belonging to this project
or selected ones only. A word regarding security, in case you are wondering, why
you don’ have to logon to the iSeries server during conversion. Your user ID and
password have been stored during the WebFacing project setup and will be re-used
here.

You are ready convert and run your application. Continue to the next module.
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Chapter 3. Converting selected source members

In this module, you will learn how the WebFacing conversion creates the JSP files
for the browser User Interface description, XML files for record format layouts, and
several other files needed for the Web application. You will learn how to select the
convert option, start the conversion and work with the conversion logs to check
the results of the WebFacing conversion.

In the previous exercise you specified the complete information the WebFacing
Tool needs to successfully convert your application; now you’ll do the conversion
itself. On the WebFacing Project icon you will select the convert option, to start the
conversion, and you'll work with the conversion logs to check the results of the
WebFacing conversion.

In order to convert selected source members, there are several steps you will need
to learn about and follow:

* Selecting certain source members for conversion using the WebFacing Tool
* Starting the conversion process using the WebFacing Tool
* Analyzing the conversion logs.

In order to accomplish these learning objects, there are several steps that are
involved, including:

* Selecting the project and source members
* Starting the WebFacing conversion

* Analyzing the conversion logs
The exercises within each module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 5 minutes to complete.

Selecting the project and source members

You will use Development Studio Client to do the WebFacing conversion, if it is
not up and running already, start it now. If it is still up and running on your
workstation you are ready to go ahead.

If the WebFacing perspective with your project is not visible, you need to open the
WebFacing perspective.

To open the WebFacing perspective:

1. Check the side bar of the workbench for the WebFacing perspective icon and if
you find it, click on the icon to switch to the WebFacing perspective that is
already open but not active at the moment.

Tip: Avoid having too many instances of the same perspective open. It will
improve performance of the workbench if you restrict yourself to one instance
of a specific perspective being open. We have seen situations with 50
perspectives being open at the same time; this has caused severe performance
impacts, so be careful.
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Here you see the icons on the sidebar of the workbench. The Remote System
Explorer perspective is active. The workbench window title bar shows this.
Four perspectives are open in the workbench:

&P Remote System Explorer - Welc

File Edit Mavigate Search Project

I -HE & J 2 _“ t‘ -

A Remate Systems
= (B R
=+ =§ Mew Connection

M3 Local
=18y s400a

« T The WebFacing perspective

« @ The Remote System Explorer perspective

& The Java perspective
+ @ The Web perspective
2. To switch to the WebFacing perspective. Select its icon T from the sidebar.

Tip: The icon & on top of the sidebar allows you to open a new perspective.
Next you start the conversion in the WebFacing perspective.

To start the conversion:

1. Select the WebFacing project you have been working on in the previous
module, wflabxx.

2. Expand this project by clicking the plus sign (+) beside its icon in the
WebFacing Projects view if its not already expanded.

CL Commands

DDs

<5400a>WFLABO2/QDDSSRC{ORDENTD)
-2y <s400a>WFLABDZ/QDDSSRC{SLTCUSTD)
= <s400a>WFLABO2/QDDSSRC(SLTPARTD)

=53 UM Help

! (73 «s400a>WFLABOZJQPNLSRC(ORDEMTRPNL)

-8 Style

| @# indes, bikml

B logon.jsp

s

WebFacing Projects ]Navigatar | Server Configuration

You should see a DDS folder in the expanded view.
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If you don’t see a DDS folder, you might be in the Navigator view and not in

the WebFacing Projects view.

Check that the view title bar is not WebFacing projects.
Locate the WebFacing Projects tab at the bottom of the list view, and click it.

cing Projegtsm |

Lgy CL Commands
DD=

UIM Help

7§ Style
Bl index.html

@ lagan.jsp

<5400a>WFLAB02/QDDSSRC(ORDENTD)
«s400a=WFLABO2/QDDSSRC(SLTCUSTD)
<5400a >WFLABO2/QDDSSRC(SLTPARTD)

#-(3 <s400a>WFLABDZ/QPNLSRC(ORDENTRPML)

WebFacing Prajects ]NwigatRﬁSewer Configuration

Now the WebFacing Projects view should be active and you should be able to

find the DDS folder.

= WebFacing Projectsi s

=1

(2 <s400a>WFLABI2/QDDSSRC(ORDENTD)
#-{2y <s400a>WFLABD2/QDDSSRC(SLTCUSTD)

1 3 <s400a>WFLABDZ/QDDSSRC(SLTPARTD)

WebFacing Prajects ]Nwigstor | Server Configuration

5. Expand the DDS folder, so that you can see all three of the members that you

selected in previous module.
Next you convert these members.
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Starting the WebFacing conversion

30

From here you can select individual members to convert or a collection of
members. When you later in this tutorial change only one source member you will
select a single member to be converted. Since you want to convert all members in
the project, you can actually work with the WebFacing project icon to convert DDS

and Panel group members.

1. Right-click wflabxx WebFacing project.

&P WebFacing - Welcome - WebSphere Development St

File Edit Mavigate Search Project Run  Window Help

) |
x|

‘WebFacin

Property

Qpen
Open With

Add
Delete...
Skyle

Convert

Wiew Log

4] Debug on Server....
ﬂ Run on Server...
@E Profile on Server...
Restart Project
Team
Compare With
Replace. With
Restore from Local History. ..

-

Properties

2. Click Convert on the pop-up menu.

The conversion process starts. You will see a progress dialog, indicating what

members are being converted:

Progress Information

@ Converting 1 - 3.

Converting: «TORASOTM>WFLABOZ/QDDSSRC(ORDENTD)

Wait until the progress dialog disappears, indicating the WebFacing conversion

has finished.
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Analyzing the conversion logs

Notice the conversion log in the right pane of the workbench:

+ ] Welcome E m;-i j( .

DSPF Conversion Log =
Display files Records
This section lists all display files that This section lists all the records in th
have been converted, converted display file.

v A WFLABO2/QDDSSRC(ORDENTD)
v & WFLABOZ/QDDSSRC(SLTCUSTD)
v’ & WFLAB0Z2/QDDSSRC(SLTPARTD)

=
| | »

Overview | Referenced Keywords | DSPF Conversion Log | UIM Help Conwersion Log |

To check the conversion log:

1. Click the Overview tab.

2. Click the Reference Keywords tab.

3. Click the DSPF Conversion Log tab.

4. Click the UIM Help Conversion Log tab.

As you click each tab you will see more details about each log.
You have now converted the DDS display file and panel group source.

The DDS source and panel group source is now available in a form a browser
understands. The first important step to move your application to the Web is done.
Notice, the conversion itself was pretty easy, because you already did the hard part
when you created the WebFacing project. Now that the project exists the
WebFacing tool has all the information readily available and even having to
re-convert later because of changes in the original source is not a big problem.

Recap

Congratulations! You have completed this module. You should now understand
how to:

* Select the WebFacing project to convert

* Select all DDS source members and all panel group source members that are
part of the WebFacing project

e Start the WebFacing conversion process

* Analyze the conversion logs to ensure no errors have occurred during
conversion

You have used the WebFacing tool to convert the user interface of the Order Entry
application and you now want to see the conversion results. The WebFacing tool
created a complete Web application that can be run in an Application Server. The
WebSphere Application Server test environment and the Web project in the
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workbench are completely integrated and without publishing (copying) any of the
files in the Web project they are known to the WebSphere Application Server test
environment.

The index.html file that has been created by the WebFacing conversion routine is
part of this Web project. It will be used as the default page for this Web
application. When the application is up and running you will go through the same
scenarios as in chapter one when you went through the green screen panels of the
Order Entry application but now you are using the new WebFaced user interface.

Next you will run your application with its new user interface. Continue to the
next module.
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Chapter 4. Running the Web-enabled application

In this module, you will learn how to test the WebFaced application. You normally
would now have to copy all the files of your Web project to a WebSphere
Application Server and then run your application there. However, there is a
WebSphere Application Server included with WebSphere Development Studio
Client and it is called the WebSphere Test Environment (WTE). Using WTE makes
the process of locally testing your WebFaced application easier than testing on a
remote WebSphere Application Server.

Later on for your production environment you would copy all files needed to your
production application server and you will learn in Module 11 how to go through
this process for the various versions of WebSphere Application Server. In your real
application development environment, you would test thoroughly in the test
environment; then export the WebFacing project files to a remote WebSphere
Application Server for final testing, before moving the Web-enabled application to
your production WebSphere Application Server environment. Module 11 shows
you the steps required to deploy to a remote WebSphere Application Server
environment. Until you are sure your WebFaced application is ready for public use,
you can use the test environment on your workstation, which simplifies the testing
of Web applications.

You will learn how to test your Web-enabled application in the WebSphere Test
Environment environment. You will learn how to specify in the WebFacing
perspective that you want to run your project in the Development Studio Client
test environment. From the initial Web page, you will learn how to select the link
created by the WebFacing Tool to invoke the WebFaced Order Entry application.

In order to run the Web-enabled application, there are several steps you will need
to learn about and follow:

* Setting up the WebSphere Application Server test environment

* Running the Web application in the WebSphere Application Server test
environment

¢ Selecting the link on the invocation Web page to invoke the RPG application

* Stepping through the Web-enabled application using the HTML-based user
interface

In order to accomplish these learning objects, there are several steps that are
involved, including:

¢ Showing the index.html page
* Running the Web application
¢ Testing the help support

The exercises within each module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 15 minutes to complete.
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Showing the index.html page
To show the index.html page:
1. Right-click the wflabxx WebFacing Projects folder.

File Edit Mavigate Search Project Run  Wind

IS-EE8 X% 0] %-

Tewy 3

Open
Open Wit »

© & gl@ |3

fidd

Delete. ..

Style 3
Convert

View Log

gﬁ Debug on Server. ..

~ -
# Run on Server...

& Frofile on Server...
WebFacine  Restart Project
| Team »

=" Compare With 3
|Property  Repface with 3
Change
Error de
Field ex Properties

Restore From Local History. .,

2. Click Run on server on the pop-up menu.
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A Server Selection dialog opens:

&P server Selection x|
server selection
Select which server to launch, Q
€ Use an existing server
Server | Status
Status:

% Create a new server
Folder: I Servers ﬂ

Server bype:

BNTEErver
- Test Environment

Ly e - all

3 C@ Apache Tomcat version 4,1
B f:%: Apache Tamcat version 4.0
EE? Apache Tomcat version 3.2

-3 Other -

Description: Runs JZEE projects out of the workspace on the local test environment.

@et server as project default (do not prompt)

ceck | met» [ Finih | cancel [

You can avoid having this dialog open every time you select run on server.
Leave the Test Environment selected.

Select the Set server as project default (do not prompt) check box.

Click Finish.

The WebSphere Application Server test environment starts. After a few
moments the browser opens in the upper right view area of the workbench. Be
patient; it takes time for the application server to start on your workstation.

The minimum memory requirement for running the WebSphere Application
Server test environment is 768 MB according to the IBM announcement letter
for Development Studio Client Version 5. You can run this WebFacing project
successfully on systems with 256 MB. It will take more time for the application
server to start if you are working on a workstation that has less than the
required memory. The system speed will also have an impact on the application
server start up time. Eventually you will see the index.html page that has been
generated by the IBM WebFacing Tool opening in the workbench’s built-in
browser.
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Here you see the browser inside the workbench with the index.html page

displayed:
C\Welcome | I whiabxx Log X l
Ihttp:,l',l'lclcahclst:‘)EIBIJ,l'wFIabxx,l' ﬂ (r] | > @ @“? & | D
=

Links for Program : "CALL OEDENTE."

Order Entry Application - Launch in main browser window
Order Entrv Application - Launch m a new browser window

H

Tip: To enlarge the browser window to the size of the workbench window,
double click on the browser title bar. To get it back to its original size in the
upper right hand workbench view area, double click on the enlarged browser
window title bar.

You have a choice of running WebSphere Application Server Version 4 or
Version 5 in the workbench test environment. In this tutorial you will be using
WebSphere Application Server Version 5 in the Test Environment and J2EE level
13.

Note: Be aware if you use WebSphere Application Server Version 4 which only
supports J2EE level 1.2, you need to setup your application server
environment to enable UTF-8 support. This setup has to be performed
for every application server that runs a WebFaced application.
Instructions how to setup the WebSphere Application Server
environment for UTF-8 is contained in the WebFacing help. In this Lab
you don’t have to worry about this step because you are using J2EE 1.3
which allows to send this information dynamically to the application
server.

Running the Web application
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In the browser window as shown you will see two links for the Order Entry
application because the IBM WebFacing Tool creates two links automatically.

* The top link will invoke a complete browser window with all the toolbars and
buttons available.

* The second link starts a new browser session for the application. This new
browser session displays just the window frame, but none of the browser menus
or toolbars are visible. This second link was added because many WebFacing
users felt the normal browser window could overwhelm some end users and
offer too many capabilities like the Back button on the toolbar.

To run the Web application:
1. In your browser pane, click the top Order Entry Application link.
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Note: For Development Studio Client Version 4 users, you have to click twice
on the link. The first click will give the browser focus; the second click
will actually send the click event.

After a few moments the first application page opens in the browser:

] Welcome | i wilabxx Log @ x |

I http: fflocalhost ;9080 wflab:c: "WFLogonZiny=INY 1 &turnCacheOff =10777324( j ()

«>2 0S| B

rder En pplication =
Parts Order Entry

Type choices, press Enter.

EEnter 2=Change

mExit

® prompt Custarmer number . ... ... | Order number
mE12

= HELP =

4] | Llﬂ

If you find the response time slow, keep in mind that the first time the JSP file
is requested, it has to be compiled into a servlet the first time. If you run the
application a second time, you will see improved performance since the
servlet already exists. This is normal application server behavior.

Now you want you to go through the same steps as in Module 1: Reviewing
your 5250 application, to review the results of the WebFacing conversion. This
will give you a sense of how the default conversion will change your original
application. You will then have a chance to improve the conversion results.

The one area that you can’t test in the built-in browser, is the Help support.
You will have to start the application from an external browser. You will see
how to do this at the end of this module. If you press the F1 key in the

Chapter 4. Running the Web-enabled application 37



38

internal browser you will see an error message as shown:

* | Welcome

FHTT

ror - Microsoft Internet Explor = I E‘_*I

ar

Googev |

| Q- © - 1] [2) ] 0 >

, @ The page cannot be displayed

|
!

cannot be displayed.
Please try the following:

to the information you want,
s Click the [ Refresh button, or try again later,

e Click @ Search to look for infarmation on the Internet.
e You can also see a list of related sites.

HTTP 500 - Internal server error
Internet Explorer

4

There is a problem with the page you are trying to reach and it

e Open the localhost: 9080 home page, and then look for links

|»

o

& [ [ & cocal ntranet

y/

Click the Prompt button, or press command key F4 to open the selection list

window.

Type choices, press Enter,
2=Change

Customer number . .. .. ..

Parts Order Entry

To select customer
Type choices, press Enter,
1=5elect

Opt Customer
[_ Oakley, Annie O

[T Barber, Elizabeth A
Farr, George

eiss, Claus
Coulthard, Phil
Gungabeesoon, Satish
Fair, Jim J
Coulter, Simon 5
Masri, Maha
Llames, Joe L

N

Fkey12=Cancel

| of

ILE RPG WebFacing application



Select a customer from the list (this is your converted subfile).

W

Type choices, press Enter,

2=Change

Customer number . ... ...

Customer name .. ..., ..:
address ...

City oo

Opt Part Description

o

«

Parts Order Entry

0004

Order number .. ... ..

weiss, Claus
8200 Warden Ave

Markham

Qty

LeG 1C7

4011

|»

Press the Enter key.

Click the Prompt button, or press command key F4 to display the parts

selection list.

Type choices, press Enter.
2=Change

Customer number . . ... ..

Customer name . ......:
address .. ... ..

Opt Part Description

Rl

a

Select Part

Type choices, press Enter,

Opt Part Description

L L =

1=Select

oooool
Qooooz2
Qoooo3
000004
0oooos
000006
Dooooy
ooooos

Qty
WEBSPHERE REDBOOK

Radio_Controlled_Plane
Change_Machine
Baseball_Tickets
Twelve_Num_Two_Pencils
Over_Under_Shotgun
Feel_Good_\itamins
Cross_Country_Ski_Set

Select a part.
Press the Enter key.

The Parts Order Entry window opens:

Type choices, press Enter,
2=Change

Customer number . ... ...
Customername .......:
Address ... L

Opt Part Description
0oo0os

Parts Order Entry

o004

weiss, Claus
2200 Warden Ave

Markham

Twelve_MNum_Two_Pencils

Order number

Qty
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8. Enter a quantity.

9. Press the Enter key.
10. Continue ordering one or two more parts.
11. Press command key F6 to accept the order.

The application works the same way as before in a 5250 environment it just
got a browser user interface.

12. Press command key F3 to exit the application.

Testing the help support

The help support will only work when you run the application in an outside
browser.

To test the help:

1. Start Internet Explorer on your desktop and key in the following in the
Address field, http://1ocalhost:9080/wflabxx/.

You could also copy it from the internal browser URL field and paste it in here.

Internet Explorer will show the index.html page:

Z} http:/ /localhost:9080/wflabxx/ - Microsoft Internet Explorer [
File Edit Wiew Favorites Tools Help | l'f
@ Back ~ (£3 - 2 J /._F\- Search ‘\j:.‘/ Favorites e\ Media @'? z
Addred & ] http: flocalhost: 9080/ wFlabex j Go
Google ~ EE
Links for Program : "CALL ORDENTER"
Order Entry Application - Launch in mam browser window
Order Entry Application - Launch in a new browser window
=
|&] Done [ [ [&Jocalintranet 4

2. Click the first link on this page.
The application will open in the browser.
Next you request help for the application.
3. Press the F1 key.
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Another browser window opens with the help information:

/2 Order Entry Application - Order entry help = =10] x|
eﬁack & E @ 'lj /':}Searth ul
Google + |
-
Esxtended help

Use this panel to specify a customer to work with. Choose
one of the following options:

s 1. Select
e 2 Enter numher

B
@] Done | [ | & Localintranet Y
4. Now try the links:
* 1. Select

* 2. Enter number

* Extended help

Your UIM based help panels are all available in the WebFacing application.
5. Close the help browser window and press F3 to end the application.

Recap

Congratulations! You have completed this module. You should now understand
how to:

e Setup the WTE
e Start the application in the WTE
* Select a link on the index.html page to star the Web-enabled application

¢ Test the Web-enabled application as you did in Module 1: Reviewing the 5250
application.

e Start the WebFacing conversion process.

* Analyze the conversion logs to ensure no errors have occurred during
conversion.

Next you want to improve the user interface generated by the WebFacing tool. In
particular, you want to improve the customer selection subfile. At the moment the
Web user interface for selecting a record from this subfile does not have the Web
behavior you would like it to have. It requires to key in a 1 into the options
column to select a record, this mimics exactly how the green screen has worked in
the past. You would like it to behave more like a Web user interface where you
select by clicking on a link.

You will be guided through the Web Setting capabilities in CODE Designer to
make the necessary modifications. You will change the second column in the
customer selection subfile, which contains the customer name, from a simple text
output field to a link. When the end user clicks on this new customer name link,
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magic will happen and the correct information your program expects is sent. You
might ask what is the correct information? What is your program expecting? It is
expecting a 1 in the subfile options field for the selected customer record. It will
exactly get the same information after you changed the user interface.

The WebFacing conversion will add logic to the user interface, so that the options
field gets filled with a 1 and the Enter key event is invoked when the link is
pressed. You enhance the user interface and don’t have to change the application,
this sounds pretty impressive doesn’t it. Continue to the next module.
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Chapter 5. Changing the user interface

In this module, you will learn how to enhance the results of the WebFacing Tool
using the feature Web Settings in the CODE Designer tool. CODE Designer is the
GUI-based screen design tool for 5250 panels. It allows you to change certain
aspects of the user interface related to the WebFacing conversion process. CODE
Designer stores the Web Setting information as comment lines in the DDS source.
When you convert the application using the IBM WebFacing Tool, these DDS
source comment lines are picked up and applied to the new user interface.

Note: You cannot use Screen Design Aid SDA on DDS source members that have
Web Settings applied. This restriction had to be imposed because SDA will
change the location of comment lines or delete comment lines, which would
invalidate the WebFacing Web Settings

You will learn how to change the user interface of your Web-enabled application
with CODE Designer. In the WebFacing perspective you will learn how to select a
DDS source member to work with; start CODE Designer to open this DDS
member; work with Web settings in CODE Designer to change the Web look, and
then reconvert the DDS member.

In order to run the change the user interface, there are several steps that you will
need to learn about and follow:

* Accessing DDS source from within the WebFacing perspective using CODE
Design

¢ Changing the Web user interface with Web settings
* Reconverting the changed DDS display file source member

In order to accomplish these learning objects, there are several steps that are
involved, including:

* Accessing DDS display file source

* Applying Web settings

¢ Testing the changed application

The exercises within each module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 15 minutes to complete.

Accessing DDS display file source

Since you will use the WebFacing perspective to invoke CODE designer you start
this exercise using Development Studio Client in the WebFacing perspective.

To access DDS display file source:

1. Start WebSphere Development Studio Client and open the WebFacing
perspective, if it is not up and running already.

2. In the WebFacing perspective, make sure that you are in the WebFacing Projects
view and not the Navigator view.
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3. Expand your project in the WebFacing Projects view by clicking on the plus
sign (+) beside the WebFacing project icon.

To start CODE Designer:

1. Expand the DDS folder.

2. Right-click SLTCUSTD source member inside the DDS folder.
3. Click Open With > CODE Designer on the pop-up menu:

I “WebFacing Projecks

=T wlabxx
EQ CL Commands
=& oDs

M-
H New 3 ,
(2 <s400a=WFLa " ParTD)
&£ UM Help
s;h Style Open With »
Bl index.html —
B lagon.jsp
Style 3
Corvert
Wigw Log
Properties

CODE Designer loads the DDS member. This takes a moment.
The DDS member loaded in CODE Designer opens:

m <ROS400A>WFLABOT/QDDSSRC{SLTCUSTD) - CODE Designer — |ﬂ|~)_<_|
File Edit Yiew Insert Selected Tools Help

BERREE &) @3|@|@||@|¢|!

(B8] <RO5400A>WFLA | Detail(] SCREENT [Jhowce | Listing |
& screen Records in il <A054004>WFLABO7/0DDSSRC(SLTCUSTD)

Record | Type | ‘window | Date | Description

B DUMMY  Standard 03/09/...

%SLTEUST Standard Window,., 03/20/...

EUS TSFL  Subfile Window... 10/30/.. Select Customer List
%CUS TCTL Subfile Con.. Window.. 10/30/. Select Customer List- ¢
4| | i

Selected DDS |Web Settings | Comments | Error fist |

o

i il _|J

4. Select the SCREENT1 tab on the notebook.
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You should now see a dialog similar to:

<R0OS400A>WFLABO7,/QDDSSRC(SLTCUSTD) - CO| igne 10| x|

File Edt Wiew Insert Selected Tools Help

(E]a]olal®m

HEEEE]ER)

7 @) <ROS400A>WFLABC| Detals SCREENT | Souce | Listing|
+- S SCREEN1

&) [FcusTsr EERE
E" Ignare all indicators j
e

solect customer

uit

Selected DDS l‘w"eb Settings | Comments | Error list |

[

A R CUSTSFL TEET( ~

A SFL

A OPT 1¥ 0B 7 ZEDTCDI

A VALUES

A CUSTOMER W4 0 7 S

A ¢1D R H -
y | L | A
| |2

As you see, you are working with the green screen image in CODE Designer.

Do you recognize the screen? It is the customer selection list. This is the screen
you will change, so it will appear more Web-like to the end user after
WebFacing Tool has been run.

5. Click the second column of the first row in the subfile (the Customer field):

Details SCREENT lSoume] Lisling]
[ «]=])[cosTomer -][s] [0 & [x]
= S =] TE

@]cusmn

%] lgnore all indicators
=ccnd Eoiles

L) RO =

(2,1 .N

0 select customer

Selected DDS lWeh Settings | Comments | Eror list |

I

A

CUSTOMER 304 0 7 5
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Applying Web settings

Now work with the Notebook underneath the Design page.

To apply Web settings:
1. Locate the Web Settings tab.

Details  SCREEN1 ISGUICEI Lislingl

[ [EcusTsr [« ] fcusTomer =][F) [0 [T
|1_7._-,Ilgnore all indicators - . b - J E
2 3 4

b - o e I e R $pe=m=tfen=

ct customer

Selected DDS‘ ‘wieb Settings ’Eomments I E rror list I

=3 CUSTOMER
Lofe) Visibilibg
~oo] Location
- [¢f] Program defined HTML
~[td) User defined HTML
l¢f] Appearance and Text
Ingert HTML
- l¢f] Create graphic
; "‘o Create hyperlink
“o[¢f] Dynamic key label

-

1)

2. Click theWeb Settings tab.
The Web Settings page in the CODE Designer window opens:

Selected DDS  Web Settings | Comments | Evror list |

[=-=3 CUSTOMER
L@ Visibily
L] Location
6] Program defined HTML
~[¢] User defined HTML
[t Appearance and Text
o] Insert HTML
o[e] Create graphic
5] Create hyperlink
- [¢] Dynamic key label

=

==

3. On the Web Settings page, locate the list that shows the different Web settings
available for the Customer field.
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4.

© © N o u»

10.
11.
12.

If not all Web Settings show, scroll down to the bottom of the list, and click
Create hyperlink in the Web Settings list:

Selected DDS  Web Settings I Comments | Enor st |

=+ CUSTOMER £ ¥ Kreate hyperink
[0 Visibility . .
Location I~ Ovenide browser's hyperlink appearance with DDS appearance
) ™ Specify static URL
Program defined HTML

0]

@ Choose a field .
[ User defined HTML A I 'l [rsert figld value
G

Appearance and Text URL |

T.-'Jr:c'tl—

(" JavaSciipt hyperlink

Insert HTML

Select the Create hyperlink check box to the right of the list.

Click the Action hyperlink radio button.

Leave the Position cursor to field check box selected

From the list under the Position cursor to field select the &{OPT} value.
In the Enter data list type 1.

This indicates that you want a 1 to be entered in the Options field when the
hyperlink is clicked.

Select the Submit check box.

Leave the Function key radio button selected.

Select Enter from the Function key list.

Just to recap, you specified the following, when the application gets converted
with the WebFacing Tool. The customer name cells in the subfile will be
generated so they appear as links in the browser window. At run time, when

the link is clicked, a 1 will be placed in the Option field. Also, a submit
request will be initiated to generate the equivalent of pressing the Enter key.

You have accomplished the basic task, but the user interface now has an
Option column that doesn’t belong there since it is useless with the new link.
Also the instructions on the page on how to select a customer are wrong. You
want you to fix this with Web Settings as well before you test this new
feature,
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Hiding the option heading

On the Design page, you now need to select the option field to indicate that you
want to work with it:

Selected DDS Eeh Setingd| Comments | Emorfit]
= OF |
s> O
5

To hide the option heading;:

ield  Show field

1. Click the Opt column on the first record in the subfile to select it.
2. On the Web Settings page select Visibility from the list.
3. Select the Hide field radio button.

Now this column in the subfile will be hidden.

Hiding the option heading for the option field

You need to hide the heading for the option field as well. The heading is not in the
subfile record it is located in the subfile control record. Therefore you need to give
focus to a different record format in the design screen. What does this mean? It
looks like one record format but there are two record formats in this view.

Lets look at some of the CODE Designer features. Normally in the iSeries green
screen world, your screens are made up out of multiple record formats that at
runtime get assembled by the RPG or COBOL program to present the real screen
your end user sees.

To make it easier for you at design time to get a feel how the record formats you
create would look like at runtime, CODE designer has added the notion of a
group. You can assemble several record formats in a group this feature gives you
the capability of mimicking what happens at runtime with your record formats. So
a group resembles the runtime grouping of record formats for you at development
time. In the sample you are working with, there are already assembled three record
formats in group SCREEN1. The record formats:

* CUSTSFL
* CUSTCTL
» SLTCUST
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To get a list of record formats belonging to a group you can expand the list of
record formats:

Only one record format in a group is active at a time. The record format name is
listed in the top field of the combo box. Also in the design window all parts in the
active record format are shown in regular density but the inactive record format
content is dimmed. You see this effect very clearly above. Until now you have been
working with the subfile record format CUSTSFL only, but now you need to clean
up the subfile control record format CUSTCTL, so you need to make it the active
record format or another way to describe this, give it focus.

To shift focus to another record format:
1. At the top of the Design page, click the arrow:

l Details SCREEN1 |S|:|urc:a] Ijstingl

.WDP]

| I lgnare all indicators

B

You will notice that the top area of the Design page is now highlighted, and the
bottom one has only half intensity. As mentioned before the highlighted area is
the one you can work with.

Next you clean up the subfile control record format.
To clean up the subfile control record format:

LD ELEE Dl Rzl
|gmre all indicators ;—_I I_E -

Selected DDS CWeb Settings: Comments | Error list |

=I-£4 'Opt Customer'
[&] Vishilty
[#] Location
- [e] F'rograrn defined HTI‘
[

o Appealance anl:l Te:-

[

[~ Change style class |

™ Ovenide constant text I

) From [4
@lde characters T “CDi

2. On the Design page, select the OPT Customer constant.

3. On the Web Settings page, select Appearance and Text from the list.
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4. Select the Hide characters check box.
5. Leave 1 in the From field.
6. Type 3 in the To field.

This hides the heading Opt. Now you need to get rid of the instructions on the
panel that guide the user to put a 1 into the Option field to select a specific
customer.

Hiding the select instruction

You don’t have to give focus to a different record format since this constant is also
located on the ORDCTL record format.

To hide the select instruction:
1. Select the constant 1=Select in the Design page:

(& [Ecuster SR =@
‘ﬁllgmre all indicators j |

Scooitooo

EA asslast
| ‘:iiﬂf@ " Show field

2. On the Web Settings page select Visibility from the list.
3. Click the Hide field radio button.

Changing the instruction (Type choice press Enter)

Now you need to add new instructions for the WebFaced page, so the end user
knows to click the link to select a customer.

Note: Note you can’t just change the 5250 constant because you might still use this
screen in a 5250 environment, you have to use Web Settings to apply this

change to the Web user interface only.

To change the instruction text:
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1. Select the instruction constant (Type choices press Enter) on the Design page:

| 7 Opt Customer

=-A Type c.. Enter.’
) Visibility
|9 Location
(0] Program defined HTt

.

o) Appearance and Terl

G

™ Change style class |

H
iveride constant te:d< Click on link to select ’
L= |

% [ Hide characters

On the Web Settings page, select Appearance and Text from the list.

Select the Override constant text check box, and type the new text Click on
Tink to select in the field to the right of the check box.

Now all Web Settings are in place and you can go ahead and save the DDS
source and reconvert this DDS member.

To close CODE Designer and re-convert the DDS member:

1.

Click the X button at the top right corner of the CODE Designer dialog.

BH <R15400A>WFLABO2/QDDSSRC(SLTCUSTD) - CODE Desighe =10y
File Edit view Insert Selected Tools Help
ElsTolaEE) - 5 e El=E @)

[ ml <R15400a>WFLA |l Details  SCREEN1 | Source | Listinal

Click Yes to save, when asked to do so.

You return to WebFacing perspective in the Development Studio Client
workbench.

Select your project wflabxx in the WebFacing Projects view.

Expand the project by clicking on the plus sign (+) in front of its icon, if you
can’t see the DDS folder as part of the project.
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5. Expand the DDS folder, if it is not expanded already, to show all members in
this folder.

i ‘WebFacing Projects
= wiflabix
% (g CL Commands
=-{z DDS
DGy <sqnua>WFLnBu?rQDDSSRC(ORDENTD)

(SR <40

i ." <S4DEIa>WFLABEI?,I'QDDS

@£ UM Help Open

e SC' Strle Open With »
__{ indes. bt - -
:/ lagon. jsp Add

Delete

Properties

6. Select the member SLTCUSTD that you just changed.
7. Right-click SLTCUSTD member icon.
8. Click Convert on the pop-up menu.

Only this member will be converted. A conversion report opens after the
conversion is finished. Now you test the new user interface.

You return to WebFacing perspective in the Development Studio Client workbench.

Testing the changed application

52

Let’s see the new user interface in your application.

To test the changed application:

1. Right-click the wflabxx project icon in the WebFacing Projects view.

2. Click Run on Server on the pop-up menu.

3. Go to the browser pane and click the Order Entry Application link.

You will see the first screen of your application. Nothing has changed there.

4. Click the Prompt push button, or press command key F4.

[ http:localhost 9080/ wlabixxWiLogonzinv=INv1 &tumCacheoff=10777 »| @ | = = @ &9 & |

4

Type choices, press
mEnter 2=Change
mCancel
= HELP Customer number . .

Order Enﬁ Rppﬂcaﬁon =

Parts Order Entry

g

To select customer
Click on link to select

Customer
Oakley, Annie O
Barber, Elizabeth &
Earr, George
Weiss, Claus
Coulthard, Phil
Gungabeesoon, Satish
Fair, Jim 1
Coulter, Simon S

Masri, Maha =
. v

http:{flocalhost: 2080 wflabx/WebFacing#
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The customer selection window appears and the customer fields are shown as
links. Also notice the changed text and the non-visible option column.

5. Select a customer from the list by clicking on the link.

6. Go through the same steps as in Module 1: Reviewing our 5250 application,
and try it out.

Recap

Congratulations! You have completed this module. You should now understand
how to:

* Access a DDS source member using CODE Design.
* Change the Web user interface using Web Settings in CODE Designer
¢ Convert the changed DDS.

Note: There green screen user interface has not changed if the application is
invoked as a green screen application. It will look like the original user
interface. The Web Settings apply only to the WebFaced user interface.

You didn’t like the way the WebFacing tool mapped some of the display attributes
to colors and text styles available in the browser. You wanted to change the default
WebFacing style rules that govern how certain 5250 parts are displayed in a
browser to give the Web user interface a better look. You learned how to change
the style rules for highlighted fields. However, there are more customization steps
to further enhance the pages of your Web application. Continue to the next
module.
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Chapter 6. Changing the style of the Web user interface

In this module, you will learn how to change the user Interface of your
Web-enabled application by using the WebFacing style properties dialog. The style
changes are applied on a project level; so all pages in a project will be displayed
with these changes applied. In this exercise we want you to change the text color
and font for all highlighted fields. Also you will learn how to locate the .css file
where these changes have been stored.

You will learn how to change a style to tailor the Web interface to your needs. You
will start the Style Properties dialog, create a new style, change style settings,
specify the new style to be used for this project, and refresh the project with the
new style.

In order to change the style of the Web user interface, there are several steps you
will need to learn about and follow:

¢ Creating a new style using the WebFacing Style Properties dialog
* Using the field-level properties pages to change the look of your Web pages
* Changing the project to use a different style

In order to accomplish these learning objectives, there are several steps that are
involved, including:

* Changing the rules for highlighted fields
¢ Changing styles directly
* Testing the changed application

The exercises within each module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 20 minutes to complete.

Changing the rules for highlighted fields

During this exercise you will use the Style Properties dialog in the IBM WebFacing
Tool to tailor your Web user interface. You will change the rules for highlighted
fields in the 5250 panels so they appear more visible in the Web user interface. The
style for highlighted fields will be altered so at runtime the text font will be
different and a larger font size will be applied.

To change the rules for highlighted fields:

© Copyright IBM Corp. 2001, 2004 55



56

1. Start the workbench of WebSphere Development Studio Client and open the
WebFacing perspective, if it is not up and running already.

ng Projects

Mew

Open
Open With

Add
Delete...
Style

Convert
View Log

A Runon Server...

Restart Project
Team

Compare ‘With
Replace With

qﬂbebunonierver"

@gProfieonSGrveru

Restore from Local History...

2. Right-click the wflabxx project.

3. Click Properties on the pop-up menu.

The WebFacing project properties dialog opens:

&P Properties for wilabxs:

=1 Corversion

i Command Key Recogrition

- Command Key Button Labe

- Edit Code Options
MNLDDS Cptions

- %ML Record Metadata

i Custom Tags

El -Run Time

- Order Enkry Applicatiol
- DDS Object Mappings
UIM Object Mappings
~\Web
- Struts
Command Key Actions
- Style

< |

Project

—Settings used for the conwerted web application:

Host name: | TORASO7M Host port: | 4004
I™ Prompt once For user 1D and password
I~ Sign on with specified values

User id; I

Passward: I

Corfitm password: I
¥ Enable users to change expired passwords
™ Use user-defined signon page
Use fixed height For the converted web page

¥ Handle as if DDS Files are complled with DFRWRT(*YES) option

™ Use insert mode for keyboard text entry

I Include command key name in the key label (2., Indude "F3="in "F3=Return" labsl)
™ Enable Web page compression

- —

Errar detail level(1-3): |3 'I

W Field exit key:

[ ]

Cancel |

4. Under Style in the left pane of the Properties for wflabxx, click DDS Field

Display Attributes.
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In the right pane of the Properties for wbflabxx, the DDS Field Display
Attributes pane opens:

&b Properties for wilabxs:
1+ Conversion DDS Field Display Attributes
| Command Key Recognition
Command Key Button Labe  yoy can customize how each DD display attribute appears on the Web page by changing the
Edit Code Options corresponding item,
MNUDDS Options
- ¥ML Record Metadata
Custom Tags
=1-Run Time . 5
- ciza: |9
[ & Project Alignment Font-size | I Sample
- Order Enkry Application
D05 Obleck Mavpbs Defauk fid fort: | Verdena, Regulr, 3 ] | Sample
LM Object Mappings
Web glinking: I\l‘ﬁtdana, Ttalic, 9 J | Blinking
Struts
Command Key Actions Column separators: I cseparator.gif J
- Style —
DDS Field Color Repeat: IRepeat horizontally "l -
DDS Field Display Attribute Position: I—Z
- Window
Subfile o ( )
Command Keys High intensity: I\"otdana, Bold, 2 J Bold
Underline: |\u'erdena, Regular Underline, 9 J I Underline
Protected: — | oo
I S |

[k ]| conee |

5. Click the .. push button to the right of the High intensity list.
The Font dialog opens:

O 2 x
Fant: Fant style: Size:
[Comic Sans MS Bold [ o |
I Centaur ~| [Regular 12 4
- : Cancel |
= alic J
’g Courier Mew 20
CourierThai 22
() Estrangelo Edessa ﬂ 24 ;I
I~ Stikeout
[ Underline | ﬁaBbYYZz
Calor:
I- Black - l Seripk:
|Western |

6. Under the Font list, select Comic sans MS.
7. Under the Font style list, select Bold.
8. Under Size, select 16.

Note: Don’t try to change the color in this dialog, the color setting doesn’t
work, later in this module you will see how to change the color.

This changes the font size and appearance for parts that have the high
intensity attribute active.

Chapter 6. Changing the style of the Web user interface
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9. Click OK on the Font dialog.
10. On the Properties page, click OK.

Testing the Web application

Let’s check the new style in your application.

To test the application:

1. Right-click the project icon in the WebFacing Projects list.

2. Click Run on Server on the pop-up menu.

3. Go to the browser pane and click on the Order Entry link.

You will see the first screen of your application.

Note: See the different font and font size of some of the text; these are the
highlighted areas of your 5250 screen.

4. Prompt for the customer.

The customer selection screen has highlighted text and this text should show in
font Comic sans serif and size 16:

BEnter
mCancel
mHELP

Type ch
2=Ch

Custom

er b pplication

Parts Order Entry

To select customer

Click on link to select

Customer

Oakley, Annie O
Barber, Elizabeth A
Farr, Gearge

Weiss, Claus
Coulthard, Phil
Gungabeesoon, Satish
Fair, Jirn J

Coulter, Simon S
Masri, Maha

Llames, Joe L

Fkeyl2=Cance

Er ...

Note: If the text is still showing the old fonts, most likely the browser has
cached the page and you need to close the browser window, and restart
the application, that will bring up a new instance of the browser without
cached content.

5. The Font dialog has a bug that makes it impossible to change the style directly.
Next you see how to directly change WebFacing style classes.

Changing styles directly
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Instead of working with properties in the WebFacing project you can also change

the styles being applied direct in the Cascading Style Sheet (.css) file that

WebFacing uses. In this exercise you see where this file is located at in the
WebFacing Project structure and how to find your way around in this file.

To locate the Cascading Style Sheet file:
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1. Click the Navigator tab to switch to the Navigator view:

\WebFacin

=-(2 oos

<5400a >WFLABO7/QDDSS
<5400a>WFLABO7/QDDSS
- #-(2y <s400a>WFLABO7/QDDSS
-0 UM Help

8§ Style

B index.html

LB logon.jsp

1] / i

WebFacing .. { Navigator JBerver Con...

2. Locate the apparea.css file in the WebFacing project:

El'-!a'-fig-atof- v X

| wSF|

E" Q wiflaboox -
#-{= config

[#-{z= JavaSource
= WebContent
[#-(z= ClientScript
--B images
(= META-INF
[#-{z= Record]SPs
[z services
== styles

- [@) cseparator.gif
o @ CurrentSegment

[ Downarrow,gif
~[®) LeftArrow.gif

P @ next.aif =
4 B i

WiebFacing ... | Navigator |Server Con...

It is located in the following directory hierarchy: wflabxx\Web
Content\styles\apparea\

Note: For Version 4 users: The directory structure is slightly different:
wflabxx\webApplication\styles\apparea\

3. Double-click the apparea.css file icon in the Navigator view, to open an editor
for this file.

Next you change the WebFacing highlighted style class.
The editor dialog will come up and show the style source.
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4. Scroll down the source file until you reach the .wf-hi class:

PAaCKIJround-coLlo0r t BeCoCII ) _:J
}

~wf bl |

font-style : italic:

}

LWL =2 |
hackground-image : url (cseparator.gif):
hackground-repeat : repeat-x;

hackground-position : 0% 120%;
3

.wE_hi

{

font-style:inormal;
border-left-color:black: -J

font-family:Comic Sans M3
horder-top-color:black:
font-weight:kbold:
font-=ize:lépc;
}
SPAN.wf_ul {
text-decoration @ underline:;
}
.mf_;r {
border-width: 0 0 2 0O;
color: H666666;

H
~WE_nd_pri

wvizibilicy: hidden
\ -
kil _I_I

You'll notice your changes from the previous exercise being applied here. The
WebFacing tool has created style sheet classes for the different 5250 parts and
attribute combinations and stored them here. Each of the lines starting with a
dot is containing a style class name. The statements inside the curly brackets

after the style class name describe the attributes of the class itself.

For this WebFacing .css file, the name of the classes are self describing, for
example .wf_hi defines how a part that has the highlighted attribute active gets
displayed in the browser, wf_cs describes the column separator, etc. You can go
in and change the display characteristics for any of the 5250 attributes.

Next you change the color attribute of the highlighted class.

Position the cursor at the end of the last line of the wf_hi class, before the
ending curly (}) bracket:

6. Press the Enter key to insert a line.
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7. Insert the color attribute you want to use, for example: color: red;:

background-repeat @ repeat-x; ﬂ
bhackground-position : 0% 120%;

H

.wf_hi

{

font-style:normal;

border-left-color:black;

font-family:Comic Sans M3
bhorder-top-color:black:

font-weight:bold;

- = Rrt:
color: red; J
H

SPAN.wf_ul {
text-decoration @ underline;
H
.Uf_p‘-_' {
border-width: 0 0 2 O;
color: HEEE6E66;
H
-wf_nd pr{

wisikbilicy: hidden B
i il
LN

Note: Don’t forget the semicolon to delimit the line.
8. Save the change by clicking the save icon in the workbench.

@WebFacing - apparea.cs

File EHyle Panes Pre
e NEE
g‘ | 5. Mavigator

For version 5 users, there is a nice feature available in the Style sheet editor
that allows you to look at the changes you have made to a class directly in the
editor without actually invoking the page and showing in a browser.

9. Look at the left beside the ccs editor:

Selected Style
Style of .wf_hi

Standard HTML Elements

Text n Body Text in Body
Text n Body Text n Body

Heading 1 Heading 1

Headiqg 2 Heading 2

Heading 3 Heading 3

To see the changed user interface, run the application again.

Testing the changed application

To test the changed application:
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1. Click on the X in the Window bar of any editors or views still open at the right
upper hand side of the workbench to close them all.

Now let’s check the new style attribute in your application.

2. Right-click the project icon in the WebFacing Projects view or Navigator in the
WebFacing perspective.

3. Select Run on Server on the pop-up menu.
4. Go to the browser pane and click on the Order Entry link.

You will see the first screen of your application. Notice the different color of the
text in the highlighted areas of your Web page. Prompt for the customer. The
customer selection screen will show the same changed attributes, remember
style changes are getting applied to all pages as shown.

] Welcome | I wlabxx Log @ x |

Ihttp:,l',l'lclcahclst:QEIBIJ,I'wﬁabxx,I'WFLognn?inv=IIW1&turnCacheOFF=1IJ?‘9?33E-32?3j e | o @ !g,“‘“) = |
UTder BTy A A

Parts Order Entry

mEnter Type choid

mCancel 2=Chan|
e Customer*:._!-o SG'?FT f-ltl.ls‘l'omer‘
Clstomer>

Barber, Elizabeth A&
Farr, George

Weiss, Claus
Coulthard, Phil
Gungabeesoon, Satish
Eair, Jirn J

Coulter, Simon S
Masri, Maha

Llames, Joe L d!

-
. [ s

Daone r\ I

Note: If the text is still showing the old colors, most likely the browser has
cached the page and you need to close the browser window, and restart
the application, that will bring up a new instance of the browser without
cached content.

You might not have noticed it before, but there is still a command key
description at the bottom of the customer selection window.

You might have guessed it; you will fix this in the next module.

Recap

Congratulations! You have completed this module. You should now understand
how to :

* Change the style for WebFaced highlighted fields using the WebFacing
properties dialog

* Apply a new font style and a bigger font size
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¢ Test these changes and made sure they are applied to all screens. You found that
the changes were applied without a re-conversion of the DDS source. Style
changes were directly applied at runtime and didn’t require re-conversion

 Edit the Cascading Style Sheet file directly with the style sheet editor, to change
the color attribute of the WebFacing highlighted style class

* Saved your changes and test the application to make sure these changes would
appear on the application screens

In the sample Order Entry application, the Customer Selection list window doesn’t
follow the CUA® rules for command keys descriptions. The WebFacing tool will by
default not recognize these command key descriptions and will not delete them.
The Order Entry main screen has a command key enabled that has no description
associated with it. The WebFacing tool by default can’t handle this situation and
puts a default string in the push button label representing this command key. Next
you learn how to enable the WebFacing tool to deal with these common green
screen environments. Continue to the next module.
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Chapter 7. Adding command key rules and labels

Most of command key descriptions placed at the bottom of the original panels in
the sample Order Entry Application have been removed from the WebFaced user
interface. The removal happens automatically if the command key descriptions
follow the Common User interface Access (CUA) rules (for example, F3=Exit). If
they don’t follow these rules you can supply the WebFacing Tool with the
command key description rules you use in your user interface, and the WebFacing
Tool will apply these rules to recognize your specific command key descriptions.
One of the record formats in the sample application contains a command key
description that doesn’t follow the CUA rules.

In this module, you will use the WebFacing conversion properties dialogs to add
your own command key description rule. Also in your user interface you might
have enabled command keys without describing them in the user interface because
they are only used for specific functions and your end user knows how they work.
For example command key three for ending an application or command key 12 for
canceling a task are well known to be enabled for these tasks. So your user
interface might not list them explicit at the bottom of the panel. The problem with
this kind of user interface design, the WebFacing tool doesn’t have a string it can
put in the label of the push buttons on the Web page. It will just put for example
CA12 for an active command key 12 in the push button label. However there is a
way out, the WebFacing tool allows you to specify labels for these common
command keys so it can label the command key push buttons correctly. You just
have to tell the WebFacing tool in its conversion properties what the label is.

In order to add command key rules and labels, there are several steps you will
need to learn about and follow:

* Adding your own command key recognition rules to the WebFacing conversion
properties

* Adding command key labels, for command keys that have missing labels in the
DDS source

* Working with command key recognition patterns

* Working with command key labels to fix the deficiencies in the WebFaced user
interface

* Reconverting the user interface with the new WebFacing conversion properties
being applied

In order to accomplish these learning objectives, there are several steps that are
involved, including:

* Working with command key description patterns
* Adding command key button labels
* Running the Web application

The exercises in this module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 15 minutes to complete.
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Working with command key description patterns

The prefix for the command key description in the SLTCUST record format is
Fkey=.

N ity weiiva

Coulthard, Phil
Gunagabeesoon, Satish

Eair, Jirn 1

Coulter, Simon S
Masri, Maha
Llames, Joe L

This doesn’t follow the CUA rules normally used in iSeries user interfaces, so the
WebFacing conversion does not recognize this pattern and does not hide it. You
have to add this prefix pattern to the WebFacing Tool conversion rules in the
WebFacing Properties dialog.

To work with command key description patterns:
1. Right-click your WebFacing project wflabxx.
2. Click Properties on the pop-up menu:

WebFacing F'ro]ects ._

JFlah
& c Mew »
E [El o Opef
B (: Open With b
R
L WG Add
®LPU  Delete...
#8595  style >
@? ir
i @ e Convert
’ View Log
4}8 Debug on Server, ..
jﬁ Run on Server...
@‘3 Profile on Server...
Restart Projest
Team »
Compare With »
Replace With »
Restore from Local History. ..
i Properties
‘WebFacing P

The Properties for wflabxx dialog opens:

&P Properties for wilabxx

El- Conversiom Project
O —— -Settings use
. Edit Code Options Host name:
- MNUDDS Options
£ XML Record Metadata I™ Prompt o
eCuskom Tags

=]+ Run Time: r Sign on v

3. In the left pane of the Properties for wflabxx, select Command Key
Recognition Patterns.
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The right hand pane will switch to Command Key Recognition Patterns.

Reconverting DDS members

Since these are conversion properties you are changing and not style properties as
in the previous module, you will need to reconvert all members that contain
command key descriptions with this pattern. In the sample Order Entry application
this is only member SLTCUSTD.

To reconvert DDS members:

1.

After the conversion, take a look at the change.

Testing the applied new rule

Let’s see how the new rule is applied to your Web-enabled application.

To test the applied new rule:

Chapter 7. Adding command key rules and labels

&b Properties for wilabxx x|
B~ Conversion Command Key Recognition Patterns
H Command Key Recognition
Command Key Butkon Labe  Command keyys will be displayed as buttons in your Web application. You can identify the text on these
Edit Code Options buttons by specifying recognition patterns.
MNUDDS Cptions WebFacing parses the text constants on each screen to identify the four-part recognition patterns:
WML Record Metadata <prefix=<key number><separator ><text string>, Then it labels each command key button in your
Custom Tags ‘Web application with the detected text string, Many applications use only one recognition pattern,
=/ Run Time Example
=) Project A green-screen application that uses the prefix "F* and the separator "=" can be converted like this:
: - Order Enkry Applicatiol | F3 = Returm —----e-emrmememeee > becomes | Retun
D05 Object Mappings L
UIM Object Mappings Select or type the prefixes (such as CA or PF) and separator (such as = or :) that appear on your green
Web screens. Add them to the bable below.
Struks "
Prefix: ke ] -
i Command Key Actions Cit ‘ - SSDStey ®_—,
E- syl Prefi ator
0OS Field Color c = I St | Delete
DDS Field Display Attribute =
il o > _toew |
Subfile F = Maove Down
Command Keys Q
Select an option to handle the detected text string for the command keys shown in the application area:
¥ Remove text
™ Keep text
™ Replace text with button For all records
q | ] ™~ Replace bext with button For window records
| oK I Cancel
In the Prefix list, type Fkey.
In the Separator list, leave = .
Click Add to the right of these two lists.
The additional rule is now part of this style.
Click OK.
Next, you will test this feature by converting the DDS member and running the
application.

In the workbench in the WebFacing Project view, expand the wflabxx project, if
not already expanded.

Expand the DDS folder, if not already expanded.
Right-click the SLTCUSTD member icon.

Click Convert on the pop-up menu.

67



1. Right-click the project wflabxx in the WebFacing Projects view.
2. Click Run on Server on the pop-up menu.
If you see a message that you have exited the browser session, click OK.
3. Go to the browser pane and click the Order Entry link.
You will see the first screen of the sample application.
4. Click Prompt or press F4.
The customer selection list window opens:

] Welcome | I wlabxx Log @ x |

Ihttp:,l',l'lclcahclst:QEIBIJJ'wﬁabxx,l'WFLognn?‘inv=IN\"1&turnCache{)FF=lﬂ?9?33??441 j e | o @ !g,“‘“) = |

-

er En pphcation B
Parts Order Entry

BEnter
®Cancel
mHELP To select customer S
Click an link to select
Customer

Qakley, Annie O
Barber, Elizabeth A
Farr, George

Weiss, Claus
Coulthard, Phil
Gungabeesoon, Satish
Eair, Jirn J

Coulter, Simon S
Masri, Maha

Llames, Joe L hd|

-

Note: Notice that the command key text Fkeyl12=Cancel is gone from the
bottom of the window.

5. Select a customer or cancel by pressing F12 to return to the Order Entry
Application window.

Now that you know how to change the command key recognition patterns in
WebFacing Tool, you can add text to frequently used command keys that don’t
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have a text description in the DDS source.

e ————
EEnter TyE
= Eyit 2
B Prompt c

Lis
mHELP

Back on the Order Entry panel, you can see that the push button for F12 does not
have a description. Its label shows F12. You will learn how to fix the label in the
next exercise.

Adding command key button labels

The WebFacing tool allows you to specify command key descriptions for command
keys that are commonly used in your application but not described in your DDS
source and on your screens. This way the push button labels on the Web pages can
automatically be changed during conversion to the correct text. You will add the
description Cancel to the WebFacing conversion properties so the push button will
get created to show a Cancel label instead of CA12.

To add command key button labels:
1. Right-click your WebFacing project wflabxx.

>
B ' L open
R
E q Open With 2
i E Q fdd
LB pelete...
H8 Sk C
Wl i
@, I Convert
View Log
gﬁ Debug on Server...
jﬂ Run on Server..,
@ﬁ Prafile on Server...
Restart Project
Team 3
Compare With 3
Replace With »
Restore From Local Histary...
webFacing F

2. Click Properties on the pop-up menu.
The Properties for wflabxx dialog opens.

3. In the left pane of this dialog, select Conversion > Command Key Button
Labels.
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In the right pane of this dialog, the Command Key Button labels opens.

# Properties for wilabxx

=) Conversion Command Key Button Labels

Command Key Recognition
Command Key Button Labe  Some command keys are enabled in your application, but are not explicitly shown on your green

Edit Code Options screens. You can define the labels to be used for these command key buttons.
MNUDDS Options
- ¥ML Record Metadata IUse this page for command key kext that will not be identified by the recognition patterns on the

previous page. Select the key and the button label vou want to use, and add it to the table below.

£ Custom Tags
=1 Run Time
. = Project

P e—
Order Entry Applicatiol . I Cancel -
005 Obyect Marping: Command key: .i Button label: W =l @

UIM Cbject Mappings
Web
- SEruts
£ Command Key Actions
=1 Style
DDS Field Color
DDS Field Display Attribute
- \Window
Subfile
- Command Keys

If the keyword for the DDS command key has a text parameter, that parameter will be used in place
of the button label specified on this page. IF no label is found or specified in this wizard, in CODE
Designer, or in the keyword parameters, WebFacing will use the keyword itself as the button label,
for example, CFOS or CAD3.

| ok I Cancel

Under the Command key list, select F12.
Under the Button label list, select Cancel.
Click Add to the right of these two lists.

The additional label is now part of the WebFacing conversion properties for
this WebFacing project.

Click OK at the bottom of the properties dialog.
Next, back in the Development Studio Client workbench, test this feature.

Reconverting DDS members

To convert the application in the workbench:

1.

2.
3.
4

Expand the wflabxx project if not already.
Expand the DDS folder if not already.
Right-click the ORDENTD member icon.

Click Convert on the pop-up menu.

After the conversion, take a look at the change.

Testing the new label

Let’s see the new label for the F12 push button in your Web-enabled application.

To test the new label:

1.

Right-click wflabxx project in the WebFacing Projects view.

70 ILE RPG WebFacing application




2. Click Run on Server on the pop-up menu.

rder K1 Pp Ce
BEnter Type choices, press Enter,
mEyit 2=Change
B Prompt
Customer number ... . ... [
BHELP

4 |

If you see a message that you have exited the browser session, click OK.

w

Go to the browser pane and click the Order Entry link.

»

Check that the Cancel push button on the first page now shows the correct
label as shown.

If the push button still has the old text, restart the Application server.
Click on the Servers tab at the bottom view in the workbench.
Right-click the server icon.

Select the Restart option.

© © N o U

Run the application again.

Recap

Congratulations! You have completed this module. You should now understand
how to:

* Start the WebFacing Project Properties dialog

* Use the command key recognition properties page to change the Fkey12
command key recognition pattern for the command key label on the customer
selection window

¢ Use the command key button labels properties page to change the undefined
F12 command key label

¢ Reconvert the application and then run the application and check the changes

Now that you have a Web user interface so the green screen look doesn’t show
through as much as after the straight WebFacing conversion, you want to add

some more refinements to the appearance of your Web pages. Continue to the next

module.

Chapter 7. Adding command key rules and labels
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Chapter 8. Working with more style properties

In this module, you will learn how to change the user interface further, using style
properties. You will learn to work with WebFacing Tool style properties and check
the changes by refreshing the style and running the application.

Since a style is used on a project level, all Web pages in your project will contain
the changes you apply to a particular style.

In order to change the user interface further, there are several steps you will need
to learn about and follow:

* Working with the additional pages of the Style Properties dialog
* Working with the window properties page

¢ Working with the scrollbar/subfile properties page

* Working with the command key look properties page.

In order to accomplish these learning objectives, there are several steps that are
involved, including:

* Starting the WebFacing properties style dialog
* Changing the appearance of the subfile

* Customizing the appearance of command keys
* Checking the new style

The exercises in this module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 20 minutes to complete.

Starting the WebFacing properties style dialog

First, you will use the WebFacing Style properties dialog to tailor your Web user
interface. You will apply changes to the window layout of your screens, the subfile
appearance will be changed, and you will enhance the command key pushbutton
looks.

To start the WebFacing properties dialog:

1. Start the WebSphere Studio workbench and open the WebFacing perspective,
if it is not up and running already.

2. In the WebFacing project view, select the wflabxx project.
3. Right-click the wflabxx project, and select Properties on the pop-up menu.
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The Properties dialog opens.

0# Properties for wflabrx

[=1- Conversion
- Command Key Recognition
- Comrmand Key Button Labe
- Edit Code Options
~MNUDDS Options
- WML Record Metadata
-~ Custom Tags

-J- Run Tirne

1]

- Order Entry Application
- DDS Object Mappings
- JIM Object Mappings
- \Web
- Skruts
- Command Key Actions
[=- Style
- DDS Field Color

H:gl plav Attribute

- Command Keys

4. Under Style in the left pane of the Properties dialog, select Window.
The right pane of the Properties dialog shows the Window properties:

&P Properties for wilabxs:
I+ Conversion Window
i Command Key Recognition
Command Key Button Labe 4 window is displayed in the application area to represent a DDS WINDOW record. Vou can customize
Edit Cade Options the appearance of the window title, body and the color of the window shadow.
MNLIDDS Options ) o -
- XML Record Metadata Window areas: [Tide (&)
Custom Tags
=1- Run Time
i=I- Project Foreground
- Order Enkry Application
- DDS Object Mappings Color: I U
UIM Object Mappings
Web Font: | Comic Sans MS, Bold, 16 @
Struts
Command Key Actions
round
= Style =R .
005 Fiekd Color coor:  |—( )
DD Field Display Attribute Body
_ Image: | J )
Subfile
Command Keys Repeat: | =]
Posikion; I d
Border color: | J
| n—] -]

ok | cancel |

Select Title from the Windows areas list.

5
6. Under Foreground click the J push button to the right of the Color list.
7. On the Color Chooser dialog, click Red.
8. Then click OK in the Color Chooser dialog.
The Window Properties page reappears.

Click the -] push button to the right of the Font list.

©
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10.
11.

12.
13.
14.

15.

16.

17.
18.

Select Font Comic sans MS, size 16.
Click OK on the Font dialog.

Under Background, click the J push button to the right of the Color list.
On the Color Chooser dialog, click Green.

Click OK on the Color Chooser dialog.

The Windows properties dialog reappears:

Select Body in the Windows areas list at the top of the page:

&b Properties for wilabxs: ' . X

1+ Conversion Window
i Command Key Recogrition

Command key Button Labe & window is displayed in the application area to represent a DDS WINDOW record. You can customize
Edit Code Options the appearance of the window title, body and the color of the window shadow.

MNUDDS Options ) .
- ¥ML Record Metadata Window areas: |6ody @
Custom Tags
=1-Run Time
. 1= Project Foreground

- Order Enkry Application
DS Object Meppkge Color: | -
LIM Cbject Mappings
b Font: | Verdana, Regular, 8

Skruts

.:. Command Key Actions e
=] Style
DDS Field Color Color: | J bod
DOS Field Display Attribute ey
- \Window J £

Subfile
Command Keys

ok | concel |

In the Border color list at the bottom of the page click the J push button to
the right of the Border color list.

The Color Chooser dialog opens.
Select Blue.
Click OK in the Color Chooser dialog.

Changing the appearance of the subfile

To change the appearance of the subfile:

1. Back in the Properties dialog, under Style, select Subfile.
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The Subfile properties page opens on the right pane of the dialog:

P Properties for wilabssx

[=1-Con

=-Run
[t

E-Style

Version
Command Key Recognition
Command Key Button Labe

- Edit Code Options

MNUDDS Options

~ WML Record Metadata
- Custom Tags

Time
Project
Order Entry Application

- DDS Object Mappings

UIM Chject Mappings
Web

- Struts

Command Key Actions

DO5 Field Color
DO'S Field Display Attribute

- Window

Subfile

-~ Command Keys

i—

Subfile

The scroll bar is used to view subfile records in the converted Web page. Select background colors

and images ko be used For the scroll bar elements and the subfile records.

Subfile areas: ISuhfiIe record - odd row

Background

Q

Image: I

Repeat:

Even row

_I Odd row

Posttion: |

ok | concel |

2. Select Subfile record - odd row in the Subfile areas list.

3. Under Background, click the J push button to the right of the Color list.
The Color Chooser dialog opens.

4. Select

&P Colo

purple.

¥ Chooser

I

Decimal:

ransparent

Hex: ! FF

oK | Cancel I

Tip: If you are interested in the hex value of certain colors as they are used in
the style classes, the color chooser displays the hex values; see the value:
"993399".

5. Click OK in the Color Chooser dialog.

You return to the Properties dialog.
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6. Select Subfile record - even row in the Subfile areas list at the top of the page.

# Properties for wilabxx

=) Conversion Subfile

Command Key Recognition
Command Key Button Labe  The seroll bar is used to view subfile records in the converted Web page. Select background colors
Edit Code Options and images to be used For the scroll bar elements and the subfile records.

MNUDDS Cptions

£ Custom Tags
= Run Time
¢ [= Project
Order Entry Applicaticl
DDS Object Mappings
UIM Chject Mappings

Web
- Seruts Background
i Command Key Actions -
- Style Color: R
DDS Field Color
Image: I - =
DO'S Field Display Attribute _] 1
- \Window . Iﬁ F
Repeat: l T
Subfile e Even row |
- Command Keys Position: | ;I ;I
IC IS

ok | concel

%ML Record Metadata Subfile areas: ISubfiIe record - even row {‘ 3 }

7. Under Background, click the J push button to the right of the Color list.
The Color Chooser dialog opens.

8. Select a light green.

9. Click OK on the Color Chooser dialog.

Now at run time the odd and even records will be displayed with different
background colors. Next you will customize the appearance of the command
key push buttons.

Customizing appearance of command keys

To customize appearance of command keys:

1. In the left pane of the Properties dialog under Style, select Command keys.
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The Command Keys properties opens on the right pane of the dialog;:

# Properties for wilabxx
=) Conversion Command Keys
Command Key Recogniton
Command Key Button Labe  some command keys are enabled in your application, but are not explicitly shown on your areen
Edit Code Options screens. You can define the labels to be used for these command key buttons.
MNUDDS Options Command key states: |Buttnn dowin
- WML Record Metadata
i Custom Tags Foreground Rolover
E1-Run Time Button down
. [ Project Color:
Order Entry Application
DDS Object Mappings Font: I\l'erdena, Regular, 10
t’vlrbomect Mappings Text indent in pixels: [ 12
- Skruks Text align: | ;l
Command Key Actions
= Style vertical shign: |.qbove text EI E i
= parault |
DDS Field Color — — — — —— |
DDS Field Display Attribute |- Background
Window Vel
Subfile Color: | J
Command . |
mmand Keys Image: I button_dn.gif J ______ ] |
Repeat: |No repeat ;l
Position: | -
ICH IR

| oK I Cancel

2. Change the Foreground color for all three states of the buttons:
* Default
* Rollover
* Button down
Now you have finished customization.
3. Click OK on the Properties dialog.

Checking the new style

Let’s see the new look of your application.

To check the new style:
1. Right-click wflabxx project.
2. Click Run on Server on the pop-up menu.
If you see a message that you have exited the browser session, click OK.
3. Run the application.
4. Click Prompt.

The application window shows different colors, and the subfile records are
colored. The command key push buttons change color, depending on their
state.
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Recap

Congratulations! You have completed this module. You should now understand
how to:

e Started the Style Properties dialog
* Worked with three different style properties
¢ Check the changes by running the application

You have tested your WebFaced application and for convenience have used your
user ID and password as the default to avoid having to sign on every time you
started the application. Now you need to move the application into production and
you need the WebFaced application to prompt the users for sign on information
when it gets started. Continue to the next module.
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Chapter 9. Adding authentication

In this module, you will learn how to secure your application by forcing
authentication before the application is invoked. You will learn how to change the
run-time behavior of your application. Instead of using the default user ID and
password, the one you used when you selected the members to convert your DDS
source, you will now force the user to provide their own signon information. You
will learn how to remove the user ID and password from the CL command
properties.

In order to add authentication, there are several steps you will need to learn about
and follow:

* Securing your application by forcing authentication before the application gets
invoked

* Explaining the authentication support in the IBM WebFacing Tool
* Removing the default user ID and password

In order to accomplish these learning objectives, there are several steps that are
involved, including:

* Removing the default user ID and password

¢ Testing the authentication dialog
The exercises in this module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 15 minutes to complete.

Removing the default user ID and password

You will use the CL command properties page of the run time to remove the
default user ID and password information.

To remove the default user ID and password:

1. In the WebFacing perspective in the WebFacing project view, right-click wflabxx
project.

2. Click Properties on the pop-up menu.

The Properties for wflabxx dialog opens.
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&P Properties for wilabxx

=1+ Conversion
-Command Key Recognition
- Command Key Button Labe
- Edit Code Options
- MHUDDS Options
- %ML Record Metadata
L Cuskom Tags
[ Run Time:
= Project
I Or der Entry Applicatio
- DDS Object Mappings
-UIM Object Mappings
- eb
- Struts
- Command Key Actions
= Style
- DDS Field Color
- DDS Field Display Attribute
window
- Subfile
" Command Keys

The Order Entry application properties pane opens:

4P Properties for wilabxx

3. Under Runtime in the left pane of the Properties dialog:

4. Select Order Entry Application.

|- Conversion Order Entry Application

Command Key Recognition
Command Key Butkton Labe
Edit Code Options
MNUDDS Options
- ¥ML Record Metadata
Custom Tags
Run Tirme
[=]- Project
" Crder Entry Application
- DDS Object Mappings
UIM Object Mappings
Web
- Skruks
i Command Key Actions
=1+ Style
DDS Field Color
DDS Field Display Attribute
-~ Window
Subfile
Command Keys

Command label: I Order Entry Application

CL command: | CALL ORDENTR

tide praject settings For this command
- Settings specified for this CL command:

Host name: |70RASU7M Host port: |40D4

@gn on with specified values

Change... |

User id; I

Password I

Caonfirm password: I

I™ Use fixed height For the converted web page

[¥ Handle as if DDS files are compiled with DFRWRT(*YES) option

[~ Use insert mode For keyboard kext entry

Cancel
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5. Make sure the Override project settings for this command check box is
selected.

6. Clear the Sign on with specified values check box.
7. Click OK at the bottom of the Properties dialog.

You are back in the WebFacing project view. You have changed the
authentication behavior for this link (application). In this WebFacing project we
only have one link, but imagine that you have multiple entry points into your
application like a menu. You could specify a different authentication behavior
for each of these links. On the other hand, if you have multiple links in a
WebFacing project and the authentication should be the same for each different
link, then you can specify an authentication rule on the project level. To do this,
just go to the project properties page instead of the CL command properties
page and specify the desired authentication behavior there.

Testing the authentication dialog

As before, you run your application in the WebSphere Application Server test
environment.

To test the authentication dialog:
1. Right-click wflabxx project.
2. Click Run on Server on the pop-up menu.
If you see a message that you have exited the browser session, click OK.
3. Click the Order Entry link.
You will see the authentication dialog.

+ ] Welcome W x |
[ ttps flocalhost:9080jwflabsxWRLogonZiny=INY 1&tunCacheoff=10778082834: »] @ | & = @ ¢¥ & | [l
Please type your user name and password.
User Name: I
Password: I
| Logon I Cancel |
Done

4. Specify your User Name and Password.
5. Click the Logon push button on the Authentication dialog.

The application will run like before, if the job environment for the user ID you
specified is setup correct for this application.

If the LOGON dialog doesn’t appear, restart the Application Server.
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Recap

Congratulations! You have completed this module. You should now understand
how to:

 Use the project properties dialog for the Order Entry application to remove the
default user ID and password information.

* Run the application and where forced to provide authentication before the
WebFacing runtime would start the WebFaced application.

You have created a WebFaced application and now want to enhance the look of the
index.html page to give the start page of this application a professional
appearance. The Development Studio client workbench contains several tools to
design and enhance Web pages. Also with the workbench you have access to
sample pictures, icons, animations, and more. You will use some of these tools and
samples and enhance the page so it becomes more attractive. Continue to the next
module.
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Chapter 10. Enhancing index.html page

In this module, you will learn how to use the Web tools in the Development
Studio Client workbench to update the index.html file. The index.html is the file
created by the IBM WebFacing Tool that allows you to start your WebFaced
application. You will use Page Designer and some related tools in the workbench
to enhance the index.html page. The index.html page, the WebFacing tool creates,
is very plain. In this exercise you will add some color to it, as well as some
pictures to make it a more interesting Web page. This will give you a chance use
some of the other tools in Development Studio Client. The Goal of the exercise The
goal of this exercise is to practice using some of the Web tools in Development
Studio Client to enhance the index.html Web page. You will use Designer and
some related tools and use them to enhance the index.html Web page, and then
test the changed page.

In order to enhance the index.html page, there are several steps you will need to
learn about and follow:

* Using Page Designer components to create a more attractive browser interface
¢ Adding a style sheet to the page

* Adding a heading that moves

¢ Adding a graphic from the sample gallery

* Creating a Logo with a Web design tool

* Testing this new index.html page

In order to accomplish these learning objectives, there are several steps that are
involved, including:

* Opening Page Designer

* Working with page properties

* Linking a cascading style sheet to a Web page
* Designing and adding a logo

¢ Adding a headingl tag to the page

* Adding a picture to the page

* Adding moving text to the page

¢ Changing the text color

* Deleting default text from the page

The exercises in this module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 30 minutes to complete.

Opening Page Designer

To open Page Designer:
1. Open the WebFacing perspective, if not already open.
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You should now have the WebFacing Projects view in your workbench
environment:

= WebFacing Projects

=V wilaboo
Ci CL Commands
#-(Z DD
5 L% UM Help
= «?j Style
o -SQ gradient
index.htny
8 logon.jsp MW »
Open With 4
Style »
Conyert
Yiew Log
ga Debug on Server...
ﬂ Run on Server...
¢ Profile on Server...
Team »
\  CompareWith 4
\WebFacing Projects | Replace With 3

2. Expand the wflabxx WebFacing project.
3. Right-click the index.html icon.
4. Click Open on the pop-up menu.

The Page Designer opens in the upper right pane of the workbench and shows

the index.html page as the WebFacing Tool created it.

+ ] Welcome m X |

indesx. bkl - Untitled

Fl- |

BODY v | Standard ~

Links for Program : "CALL ORDENTR"

Order Entry Application - Launch in main browser window %

Order Entry Application - Launch m a new browser window®e

-

@Snuce Preview

Make sure that you are on the Design page in Page designer.

5. Click the Design tab.
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Working with page properties
Next you move the links down.
To work with page properties:

1. Click before the first TAG, which shows as an exclamation mark.
2. Press the Enter key a number of times:

W
&
|»

2 3 5 3 5
£ € & £ <

2
S

R R RO

Links for Program : "CALL ORDENTR"

Order Entry Application - Launch in main browser window e

Order Entry Application - Launch in a new browser window®
I..

ﬂ o
3. Right-click the background of the index.html page in Page Designer.
4. Click Page Properties on the pop-up menu.

of” Cut

Copy
I raste
# Delete

Save

Insert »
447 Tnsert Link..,

Page Properties, ..
Skyle »

attributes
& Quick Edit
Layout Mode »

-0[ Run to Line
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The Page Properties dialog opens:

4P Page Properties x|

Page Information | Meta Info |

Page title: | Order Entry|

BaseURL: |

Default target: |

Encoding: [SO 10646{Unicode(UTF-6))

L L

| oK I Cancel

5. In the Page title field, type Order Entry.
6. Click OK on the Page Properties dialog.

When this page is shown in a browser, the Window title bar of the browser will
now display Order Entry.

Linking a cascading style sheet to a Web page

Now you will add a style to the Web page, you can use a style that is used in your

company or you can use one of the sample style sheets that are provided in
Development Studio Client.

Next you open the Gallery view in the workbench.

To link a style sheet:

IF-BEe [|E%|d|a-|]|s]/ARM|ve-2- @
| ¥ 2
ﬁ WebFacing Projects x| | 1 Welcome |'§,*hdex.htm| x]
5] index.html - Order Entry * El«| P+ | Standard -
’% ﬁ wilabeoe Al window BRy -
- E ;'[');““ma”‘_ Order Entry Application - Launch in a new browser

E LIM Help windowr®

=8 style ~| L.
| |

4 3 | =

WebFa... INwigator ik Dasign‘Snurca | Preview

&} Gallery x
{!| Image
m»&- Webart
AQZ) Style Sheet

.~ ”
% Thumbnails

Style Sheet Files (*.cs5)

e | e——

spearmint00,,, Ele00Ll.css  brivet00L, wayves001.c,.
Pmpsrtles@dlery rd b @) tyles | Colors | Links | Servers | T | Consdl

1. Click the Gallery tab, if the Gallery view isn’t already displayed.
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2. Scroll to the bottom of the Gallery view, until can see the Style Sheet icon.

3. Click the Style Sheet icon, to select it.

4. Click the Thumbnails tab on the right bottom pane in the workbench.
You should see thumbnail icons of all the styles available.

5. In the thumbnail view, scroll down to the bottom, until you see style sheet
waves001.css in the list, or select a style sheet that you like best.

6. Click the thumbnail picture of waves001.css with the left mouse button.

7. Hold the left mouse button down and drag the cursor to the Page Designer
window.

®

8. The cursor will change from this shape , to this shape . When the
latter cursor shape appears in the Page Designer window, release the left mouse
button.

After a short while the Style sheet properties will be applied and the colors in
the page will change to the style sheet definitions.

] Welcome | I wlabxx Log @ x |
indesx. hkml - Order Entry * EJ - | BODY ~ | Standard -
BR‘ -

BRy
By
BRy
BRy
BRy
BRy
By
Links for Program : "CALL ORDENTR"

Order Entry Application - Launch in main browser window B

Order Entry Application - Launch in a new browser window®
I,

|

Design | Source | Preview N

Designing and adding a logo

Now that you have the overall Web page look specified, you will use the WebArt
Designer to create a Logo that you then will add to this page.

To start the WebArt Designer:

&P WebFacing - index.html - WebSphere Development Studio Client Advanced Edition for
File Edit Toolbar Insett Format Table Frame Page | Tools Mavigate Search Project R

Launch External \Web Browser »

[F-BEE|[E%|8]%-| ¢

: 2 ay] Spell Chek...

g [ WebFacing Projects = Validate HTML Syntax
Ty |2 WP wilabxx T Convertto KHTML...
’E Ef:i CL Commands
=l (g DDS i webart Designer

# L UM el (&, AnimatedGif Design ah

=-8 Style -

- B8 gradient %R,

1. Click Tools in the workbench menu.

2. Click WebArt Designer on the pop-up menu.
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The WebArt designer opens:

@ Untitled - WebSphere Studio WebArt Designer
Fil= Edit Wiew Object Tools Help

=10/ x]

[weEB| % ex -« ¢ Bz«

| B0 Wy

=13 .

¥4 Webdrt Gallery | @ Gallery | [@i
D @ ® | /¢
Button Rollover  Shapes LAY R
Text: ’\z @~
-] <&~

4 &A

—_— e ————————| 0 l

R ) A%

Setup Insert el

For Help, press the [F1] key.

-

v
I ——
» -

| [ Y

The WebArt designer shows the Template Gallery on the left, where you find
sample of logos, buttons, rollovers, images and more. The big white area in
middle of the dialog is the canvas that is used to work with objects that you
want to create or change. Although you could select a logo from the template
gallery as the base for your own logo, you will instead create you own.

Logo menu options.

. Click the Create Logo button above the canvas or use the Object > Create

% Untitled - WebSphere Studio WebArt Designer

File Edit Yiew Object Tools Help

joEBER| ¥ E B X5 v nlmlﬁﬁ@m(;)ﬁm

| B o(@mye
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10.

The Logo wizard opens:

Logo Wizard (Specify Text - 1/4) x|
Text:
( !IEM ) a
wilabwx _I
ZEBM
= \gidabizdl
-~ Font
Font name: Comic Sans M3 LI
Fortsize: €] 4621 )
Line = Character | D=
spacing: =% spacing; =
— Style Alignment
v Bald O Left
v Italic -
[ Stikethrough <" Right
[ Underline Direction
WV Antislias ’7 [ Vertical %

< Back I Next > I Cancel I Help I

Enter your company name in the Text field and in the next line of the Text
field enter the project name.

Select Comic Sans MS in the Font name list.
Select 46 in the Font size list.

Under Style, select Bold and Italic check boxes.
Leave the Antialias check box selected.

Click the Center radio button under Alignment.

Notice in the upper right corner of the dialog, a sample of the logo as
specified at the moment is being displayed.

Click Next to go to the next page of the wizard.
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The Select Color page of the wizard opens:

Logo Wizard {Select Color - 2/4) EI

/ bluer \
2

beer Others... I
K

5 {rfﬂr {s )} ’éfzﬁr

< Back | MNext > I Cancel I Help I

11. Click the gradation Type push button, the middle one of the three type push

buttons.

Note: The other push buttons select color types: solid and textured.
12. Select beer from the colors available, or any other color you like best, just

scroll through the list to find a gradation you like.

Tip: You can change the colors by pressing the Others push button on this

dialog and create you own gradation.
13. Click Next to move forward to the next page.
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The Select Outline page opens:

Logo Wizard {Select Dutline - 3/4)

Type:

~ Options

Edge width:

Edge color: _l

Transparency: P 05

Bulge for edge: rg il

< Back I Next > I Cancel I Help I

14. Select the Seal outline from the list, or any outline you like best.

15. Click Next.
The Select Text Effect page opens:

Logo Wizard {Select Text Effect - 4/4)

Type:

4

— Options

Embossment
strength:

Embossment
direction:

< Back I Finish I Cancel I Help I

16. Select the Emboss text effect or one that you like best.

17. Click Finish.
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You return to the WebArt Designer window with the new logo object.

-
S @~
AN -
Ay @ ~
4 X~
& A
4
A%
%
ZQ

B-
]

To resize the logo object on the canvas:
1. Click the logo object to select it.

2. Move the cursor to the rectangle at the right bottom corners of the object,
watch the cursor changing shape.

3. Drag the rectangle up and to the left so the object becomes smaller.

Now you need to save this object. First you want save it as a WebArt object,
that allows you later on to work with object again in WebArt designer.
However you can’t use that format for your Web page, so you will save it in
another format.

4. Click File on the WebArt Designer menu.
5. Click Save Canvas As on the pop-up menu.
The Save Canvas As dialog opens:

Save Canvas As

Save in:]l'f} \WebContent EI & B o E-

2]

) ClientScript [ UIMHelp
limages [)WEB-INF
CIMETA-INF

J)Record)sPs

) services

styles

Filenamec‘ !m_l,llogn ’ Save
Save as type: | wetdt files (*mif l% | Cancel |

I Include Carvas

Y

6. Type mylogo in the File name field.
7. Click Save.

Now we need to save the object in a form that can be displayed on a Web
page.

8. Click File from the WebArt Designer menu again.

9. Click Save wizard for Web on the pop-up menu.
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The Save Wizard dialog opens:

Save Wizard (Specify Objects) - 1/3

Specif i want to save,
(* Save the selected object

(" Specify the objects Specify... I

¢ Back Nest > Cancel | Help

10. Leave the Save the selected object radio button selected.
11. Click Next.

Now the Select File format page opens:

Save Wizard (Select File Format) - 2/3

Select a format for the image file.

 JPEG

" PNG

This format can handle only 258 colors, By saving an image as a
GIF file, you can reduce its file size. This format is suitable for
images that do nat require many colors, such as line drawings of
araphs.

“Y'ou can make pait of an GIF image transparent.

This format is in general use on the Intemnet because of its small file
size and inconspicuous image degradation. This format is suitable
for full-color images, such as photos taken with a digital camera.
'You cannot make a part of a JPEG image transparert.

This format maintains the quality of an image, but the file size
becomes larger than that of a JPEG. This format is suitable for
full-color images whose quality is important, such as computer
graphics.

You can make a part of a PNG image triansparent; however, only a
fews browsers can handle it correctly.

< Back | Na_T> I Cancel Help
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12. Leave the GIF radio button selected.

13. Click Next.
The GIF Format page opens:

Save Wizard (GIF Format) - 3/3 ﬁl
[Driginal image] [Image to be saved]
284 28
wilabios = wilabiod
File size before: 13536 bytes
File size after: 3150 bytes
— Palette — Properties
€ Use the palette for the current file ¥ Transparent ﬁl
% Use the optimized palette I~ Interlace
Colors: ]258 colors j' — Background color
Dither  |Yes v
II:ulol of the Carvas "I
< Back I [€inish I Cancel Help
A
14. Click Finish.
The Save As dialog opens:
2l
Save in: l | WebContent EI = B Q{‘ E-

) ClientScript *] waves00zbu.gif
)images

CIMETA-INF

J)Record)sPs

) services

styles

) UIMHelp

|2) WEB-INF

File name: ' |mylogl:| ’

Save as type: |GIF files [*.qif]

15. Type mylogo in the File name field.
16. Click Save.

Next you close the WebArt Designer.
17. Click File from the menu.
18. Click Exit on the pop-up menu.

You are back in the workbench in the WebFacing perspective showing the

WebFacing Projects view.
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19.
20.
21.

22.
23.

24.

25.

Next you switch to the Navigator view.

You may have to click Window > Show view > Navigator from the

workbench menu.
Click the Navigator tab.

Expand the wflabxx Web project if not already expanded.

Expand the WebContent folder if not already expanded.

= Navigator v X

[#-{z=- images
[+ (== META-INF
[ {z= RecordsPs
[#-{z= services
[ (= styles
- {z= UIMHelp
[#-{z5- WEB-INF
@' indesx. html
@r lagan. Rkl

-8 logopLisp

| mylogo.qi
mylogo.mif
s gy =i WL

webFacing Projecl | Navigator [Jerver Configurat. ..

The mylogo.gif file should appear in the list.

If it doesn’t appear, the list might need to be refreshed.
Right-click the WebContent folder icon.
Click Refresh on the pop-up menu.

Now you should see the file in the Web Content folder, if not, go to Windows
explorer and search for the mylogo.gif on your hard drive, then move it to the
Web Content folder in the Development Studio Client workspace.

If you didn’t use the default workspace location, do a search for the
workspace and the wflabxx directory in it.

Move the mylogo.gif into the WebContent directory under the wflabxx
directory. Refresh the Navigator view again.

Now you can take the logo and put it on your Web page that is still open in
Page Designer, if Page Designer has been closed just open the index.html file.

El'-lavigatnr - X

| Welcome |@v"‘index.html x|

IRl

index.html - Order Entry *

= = WebContent

| #-= ClientSeript
#-{z= images
-3z META-INF
-5 Record]SPs
E =+ services
[#-{= styles
&= UIMHelp
#-(3= WEB-INF
B indes.html
@r lagan, Rkml

-8 waves00L.css bt

recceeeeeBeececce,

‘WebFacing P'rojects—[Navlgatnr |Server Configurat...

Design |50urce |Preview .

26. In the Navigator view, select the mylogo.gif file.

Chapter 10. Enhancing index.html page 97



27. Hold the left mouse down.
28. Drag the file to the upper left corner in the Page Designer window.
29. Release the mouse button.

The logo is placed on the Design page.

Adding a heading 1 tag to the page

Now you want to insert a nice heading below the logo.

To add a heading 1 tag;:
1. Position the cursor just below the Logo at the first BR tag.

4P WebFacing - index.html - WebSphere Development Studio Client Advanced Edition for iSeries}
File Edit Toolbar | Insert Format Table Frame Page Tools Mavigate Search FProject Run Wi

| 2% - & B & Fiik.. cul+Q |% -2 - || @3
g 5. Navigator 4 Ancher... o X
= Image File 3 "
@[ > o | Background Image File p (Entry
’E =iz Wel  packground Music >
e i B
-G | Il Free Layout Table
! 3
- fe r‘
. B Normal Chrl+0
N T 3
= BT
o B Table. Ctrk+T Hearinn 5 Chlas

2. Click Insert from the workbench menu.

3. Click Paragraph > Heading 1 on the pop-up menu.
A frame appears that allows you to enter text.

4. Enter your company name Order Entry Application:

IBM Order Entry Application
|

BRy

BRy

BRy [\‘{‘3
|__BR.
Design |Source | Preview

Now you want to use one of the sample pictures that come with Development
Studio Client and place this picture on the page.
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Adding a picture to the page

To add a picture to the page:

* ] Welcome Bl tindex.html X l

index,html - Order Entry * El~ | Boov » | Standard -

IBM Order Entry Application ~

e
Design | Source |Preview
% Thumbnails !

X
Image Files {(*.aif,*.jpa,*.png,* bmp,* wmf,*.emf,* tf,* ey *, * if, *.dem) lad
-
ﬁ l m : .

a'

‘h——l’

001il.gif oozil.gif 003, gif 004il. gif 005l gif

—— o g | =

Thumbnails |Stvl&s |Colnrs |Links | Servers |Tasks |Consnle

Expand the Image folder.
Select the Illustration folder.

Hw PR

illustrations, for example, use file 005il.gif.

In the workbench in the Navigator view, select the Gallery tab.

On the dialog pane beside the Gallery view, select one of the sample

Note: The sample illustrations change from release to release so 005il.gif might

not be available in your environment.

5. Drag a picture onto the Design window below the heading.

The Design window now contains a picture:

] Welcome m x l

indesx. hkml - Order Entry * El -~ P~ | Standard -

IBM Order Entry Application -

BRy

Design | Source |Preview

You are almost done. Next you add moving text to the page.
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Adding moving text to the page

Now you add moving text to the page.

To add moving text:
1. Position the cursor in the Design page underneath the picture.
2. Click Insert from the workbench menu.
3. Click Paragraph > Heading 3 on the pop-up menu.

index. html - Order Entry * El~ | H3 - | Standard ~
=)
€
1
BRy
I A =

Design |Snurce | Preview

4. Leave the cursor positioned inside the heading 3 frame.

|Insert Format Table Frame Page Tools Mavigste Search Project Rur

5 4 Link... ctrhQ % ¢ -2 -
& anchar. ..
A Image File 3
| Background Image File >
Background Music 3

* I Free Layout Table

" Text cell
Paragraph *
Lisk ]
4 FH Table... Chri+T
~ Horizontal Rule
% Form and Input Fields ’
_ 5 Seript
\ 18] iSeries Web Components. .. =] Java Applet...
e 7 Layout Box HotMedia. ..
it == Plug-ins...
iy Line Break. .. Ctr+-Enter Object...
5 Special Characters. .. Inline Frame...
®  Non-breaking Space Chr+Shift+Space M
a
. File... Style Container (D!
) Keyword... SPAN with Style...
I’ﬁ Y Date and Time. ., aPAN
- 551 3 Comments. ..
i HTML Source...

5. Click Insert from the workbench menu.
6. Click Others > Marquee on the pop-up menu.
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The Insert Marquee dialog opens:

C§: Insert Marquee ﬁl
Text:
~EBehavior —Repetition
eS| e
Direction: | (Auto) v Caunt:®_
—Display speed — Size
Delay time: | width: | fpxels =]
Scroll amount: l— Height | [pixels ;I
[~ Use true speed

—Color

Background color: El il

I oK I Cancel

7. Enter into the Text field: Please select link to start application.

8. Under Behavior, select Slide in the Movement list.

9. Under Repetition, select Finite in the Repetition list.

10. Under Repetition, type 1 in the Count field.

The two last selections just avoid the text sliding in forever and not standing
still, if you think your user can stand some more movement on the page feel
free to change these settings.

11. Select Lime in the Background color list. Click OK on the Color palette.

12. Click OK on the Insert Marquee dialog.
The Design page should look like:

) Welcome W

x]

index. bkl - Order Entry *

E]~ © MARQUEE - ' Standard ~

TEFIVI %W Wisl]

=TILI y nPPIIUﬂI.IUI |

-

w ,|
Design | Source | Preview

Next you save some space by removing some of the line break tags.

13. Position the cursor on the BR tag.
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14. Press the Delete key until the links appear on your page:

index.html - Order Entry * El~ |

[

Standard -

2ZEM,
5"«

IBM Order Entry Application

€

4

Links for Program : "CALL ORDENTR"

Order Entry Application - Launch in main browser window ®¢

Order Entry Application - Launch in 2 new browser window®

il

Design | Source |Preview L

Next you look at the page, as it would appear in a browser.
Click on the Preview tab at the bottom of the Design page.

15.
You will notice that your heading 3 text is sliding in:

] Welcome IE‘ whlabsxx Log x ]

index,html - Order Entry *

& e

DIEM;
wilabiex,

IBM Order Entry Application

Links for Program : "CALL ORDENTR"

Order Enfry Application - Launch in main browser window
rder Entry Application - nchin a new b rwin

o,
Design | Sourdg Preview )
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Changing the text color

You notice that the Text color and the background interfere a little bit one easy
way of changing this, is to apply another color to certain areas of the text. To do
that you return to the Design page.

To change the text color:

1.

o ok w

Click the Design tab.

BA4

wrlabios,
@Order Entry Applice

€

¢

Bl | #o000ff -~ P | Text Color &)

Set as Table Background Color

Set a5 Backaroundiof Layout Box

Thumbnails |Sty|e@hks |Servers | Tasks | Console

Select the company text (IBM) you want to change color on, by swiping the text
area with the mouse cursor.

Under the Page Designer window, select the Colors tab.
Select a color with your mouse cursor.

Select the Text Color from the Colors dialog.

Click Set as Text Color on the pop-up menu.

You are done; now the selected text will be displayed with the color you
selected for it.

Deleting default text from the page

One more thing to do, you want to remove the default text that was added by the
WebFacing tool.
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To delete default text from the page:

‘| Welcome W-E x |

index. html - Order Entry *

€

i

Order Entry Application - Launch in main browser window #
r lication - inan r r window®he
Design | Source | Preview

Select the text.

Press the Delete key.

Select the Preview tab to view your completed page.
Close the file index.html.

Click Yes to save the changes.

g reN e

Page Designer is closed.
In the Navigator view or WebFacing Projects view, right-click wflabxx.

o

7. Click Run on Server on the pop-up menu.
If you see a message that you have exited the browser session, click OK.

Your new designed index.html page opens and you can run your application.

S

wilabaod

Order Entry Application

Order Entry Application - Launch in main browser windowy
rder Application - nch in a new browser window

Design | Source lPrevluw |
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Recap

Congratulations! You have completed this module. You should now understand

how to:

Opening page designer

Working with page properties
Linking to a cascading style sheet
Create a heading

Add an image

Create a LOGO and add it

Add Marquee

Change the color of text

Deleting default text

After creating and testing your completed WebFacing application, you can deploy

the WebFacing application, if you have WebSphere Application Server Express

installed on your iSeries server . If you want to deploy your WebFacing

application, continue to the next module.
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Chapter 11. Exporting to iSeries WebSphere Application
Server Express 5.0

You have tested the WebFaced application in the WebSphere Application Server
test environment and you are ready to move it to your iSeries WebSphere
Application Server production environment. You are running WebSphere
Application Server Express Version 5.0 on your iSeries server. In this module, you
will learn how to copy your WebFacing project files to the iSeries file system. You
will then learn how to install the application in the application server.

You learn how to publish your WebFacing files to a remote WebSphere Application
Server Express 5.0 environment on an iSeries host. You will start the Export tool in
Development Studio Client, specify files to export, install and start the Web
application in the WebSphere Application Server Administrative console.

In order to export to WebSphere Application Server, there are several steps you
will need to learn about and follow:

* Using the WebSphere Development Client wizards to specify the files to deploy
to the application server

* Exporting the selected EAR files to the server file system

¢ Installing the WebFaced application on the remote application server through the
WebSphere Application Server Administrative console

* Using a browser to invoke the WebFaced application on the remote Application
Server.

* Learning how to copy selected file from a WebFacing project in the workbench
to the application server, to apply small changes without having to copy the
complete EAR file

In order to accomplish these learning objectives, there are several steps that are
involved, including:

* Exporting the files to the Web server
* Exporting your EAR file

* Installing the application

¢ Testing the Web application

The exercises in this module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 30 minutes to complete.

Exporting the files to the Web server

First you copy the WebFacing project files to a WebSphere Application Server,
Version 5.0. These first steps are the same for WebSphere Application Server for
iSeries, Version 5.0 and the WebSphere Application Server for iSeries Express,
Version 5.0.

Before you export any files, you must map a network drive to the Root file system
on the iSeries where WebSphere Application Server is installed.
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To map a network drive:

1. Right-click the Network Neighborhood or (My Network Places) icon on the
desktop.

2. Select Map Network drive from the pop-up menu.
The Map Network Drive dialog opens:

Map Network Drive x|

Wwindows can help vou connect to a shared network Folder
and assign a drive letter to the connection so that you can
access the folder using My Computer,

Specify the drive letter for the connection and the Folder
that you want to connect to:

Folder: | 1s4002\QIEM | Browse... |

Example: Yiserverishare

I Reconnect at logon

Connect using a different user name,

Sian up for online storage or connect ko 3
network server,

< Back I Finish I Cancel I

3. In the Folder field, enter two backslashes \\ and the Netserver name of your
Web server, and then \root, for example: \\S400A\root.

4. Click Finish.

You now have an additional drive available on your workstation and are ready
to export your WebFacing project files.

Exporting your EAR file

The J2EE standard has the concept of an Enterprise Archive File (EAR). This file is
a zip file that contains all information about your Web application. In the
workbench, this file is built automatically for Web projects. Since your WebFacing
project is a Web project, the wflabbxxEAR file exists already. You only have to
move it to the application server, point to it, and then install the application. There
is no need to worry about the structure of the application. Everything is taken care
of in the workbench. Return to the Development Studio Client workbench.

To export your EAR file:
1. In the WebFacing perspective, click File from the workbench menu.
2. Click Export on the pop-up menu.
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The Select page of the Export wizard opens:

Select A
Export an Enterprise Application project into an EAR File M

Select an export destination:

S app Client JAR file
‘@ Deployable Features

< - lug-ins and fragments
ile

LRl system

Jerte

I3aR File

f@ Javadoc

BIRaR file

I.E‘,IR&mote file system
ngymptom database file
%% Team Project Set [%
Brar il

,lg web Service
Lzipfie

<Back [ mext> | Finish | concel |

3. Select the EAR file icon.
An EAR file is a compressed Enterprise Application Archive, and it contains all
the files needed for the Web application.

4. Click Next.
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The EAR Export page opens.

X
EAR Export
Export Enterprise &pplication project to the local file system. %
A |
Enterprise Application project name: | wilaboEAR =l
Destination: | FiiQIBMiuserData|webass|Baseidef | Browse... |

™ Expott source files
[V Overwrite existing files without warning

Advanced, .. |

5. Select the name of the resources you used when creating your WebFacing

project. This should be wflabxxEAR.

In the Where do you want to export the resources to field:

6. In the Destination field, where you want to put the EAR file by entering the
drive and directory structure of the IFS drive you mapped in the steps before.
For example, use the default directory structure for installable applications:
x:\QIBM\UserData\WebAS5\Base\default\installableApps\wflabxx.ear where
x: is the drive letter mapped from your iSeries host in the previous steps.

Note: For WebSphere Application Server Express, the default installation

directory would be:

x:\QIBM\UserData\WebASE\ASE5\server name\installableApps\wflabxx.ear
7. Select the Overwrite existing files without warning check box.

8. Click Finish.

If you see a message asking you to create a directory or delete an existing file:
Click OK or Yes and continue. Now you can install the application in

WebSphere Application Server.

Installing the application

At this point, you already need to have set up and started the WebSphere
Application Server and an associated HTTP server on your iSeries server. You also
need to find the port number of the HTTP servers Administrative Console (referred
as port#a) and the port number to run your application (referred to as port#b) The
second one is the port number of your HTTP server that is set up to work with

your application server.
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To install the application:

1. Open any Web browser and type: http://servername:port#a/ in the Address
field.

Note: The default administrative port number for the HTTP server is 2001.
The Login dialog appears.

2. Type your iSeries user ID.

3. Type your iSeries password.

4. Click OK.
In the browser:

@P IBM HTTP Server for iSeries
e theiSenias ESemrar and S5L

IBM WebSphere Application Server -

Express for iSeries
Configure application servers and deploy applications

distribute, and manage Digital Certificates

ate,

IBM IPP Server for iSeries
== Configure the IBM IPF Server

£ ,,,‘ 4758 Cryptographic Coprocessor
- l Configure the 4758 coprocessor

Related task G

formation Help
(Fequires Java Soipt)

5. Click the IBM WebSphere Application Server — Express for iSeries menu
option.

Note: You could also select the first option IBM HTTP Server for iSeries if that
is the server you are using.

The Administration pages for the HTTP and application servers display.
6. Select the Manage Tab.
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The Manage Application Server — Express page displays:

\@T‘Semrnmh ST Application Server - Express for iSeries
o L | W viao~oe
WAS-Erpress Ve ) <]

All servers -> serverl/semverl

oo serverl/serverl

Manage Application

|
The default vinual host "default_host” was  After crea
created for this alplicaﬂnn SEIVETL. you can il
However, you can specify additional virtual
hosts for more control over what URI's can

talled Applications run which applications.

¥ Resource Configuration

b - Yirtual hosts can communicate with one Applicatic
M age "nﬁ‘:flPH_'h.t; ) or more HTTP servers. When creating a applicatio
PE OGRS virtual host you must also define which users. Us

: Data Sources . K . . K
R HTTP server(s) the application will use to applicatio

serve its contents. This wizard will create  are locate
an additional virtual host and update the iSeries se
corresponding HTTP server to send

requests to the application server,

¥ Problem Determination
B|View Logs

¥ Tools
+ Launch Express Console Current ConfigL

7. Select your WebSphere Application Server Express server instance from the
Server list.

8. Click Install New Application under Tasks and Wizards list.
The Install New Application page displays.

All servers -» server l/server] -= Install Mew Application

Install New Application @
Specify Application Location

Welcome to the Install New Application wizard This wizard will install an application into this WebSphere Application Server -
Express. The application must already exist on the iSeries server in an IFS directory.

@ﬁ.pp]ication 1s contamed in an EAR file

IFS path of EAR file: [MebASEIASESFseweHfinstallahleApps-’WIlahxxEARe Browse

" Application is contamed in a WAR file

EBack | Next Cancel

9. Click the Application is contained in an EAR file radio button.

10. Specify the location of your EAR file, (the file that you exported in the
previous step).

You can use the Browse push button to locate the file.
11. Click Next.
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A page appears with options for application installation:

All servers -» serverl/server] -> Install Mew Application

Install New Application @
Provide Options to Perform the Install

Specify J.Rplij:ation deployment options

Application name: % @
ectory applicaton mstalled to: IQLE serDataWebASE/ASE S server lmstalledApps
re-compile JSPs @

Note: Pre-compiing J5Ps can have significant performance impacts. When enabled, the JSPs in the application will be
compiled at installation hme, causing the application install to take longer. When disabled, the JSPs will be compded the first
time they are accessed, causing the first use of the application to take longer.

Back| Next| Cancel|

12. In the Application name field, type wflabxx.

13. You can select the Pre-compile JSPs check box to speed up the process of
showing the page the first time. (JSPs are compiled into Servlets when first
generated.)

14. Click Next.
The Map Virtual Hosts Page appears:

Al servers -= server liserver] - Install New Application

Install New Application @
Map Virtual Hosts for Web Modules

Specify the virtual host you want to associate with the web modules contained in this appl
the same virtual host or dispersed among several virtual hosts.

Map web modules to wirtual hosts: @
‘Web module| Virtual host
wilabim

default host i

15. Select the virtual host to be associated with the Web module.

16. Select a virtual host of your choice, or leave the default host selected.
17. Click Next.
The application summary page displays:

All servers -= server lserver]l -> Install New Applcation

Install New Application @
Summary

When you click Finish the installation will be started for the following application.

IFS path Bk EAR file: [QIBM/UserData™Web ASE/ASES server linstallable AppsfwilabxEAR ear
Application name: wilab:zEAR

Directory application installed to: /QIBM/UserData™Web ASE/ASES/server linstalledApps

Pre-compile JSPs: Enabled

. ‘Web module | Virtual host
Map web modules to virtual hosts: - y
wilabaz | default_host

Back| Finish| Cancel|
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After the successful installation you see a page where you can manage the
installed applications:

d serverlfserver! - WAS - Express W5 M

All servers -» serverl/server]

Manage Application Server - Express

Create Additional Virtual Host Install New Application
The default vitual host "default_host” was  After creating the server and virtual
created for this application server. you can install your applications.
However, you can specify additional virtual
hosts for more control over what URI's can
run which applications.

............................................................ e ‘7 DEta”S .
“irtual hosts can communicate with one Applications must be installed on ar
or more HTTP servers. When creating a application server to be accessed b-
virtual host you must also define which users. Use this wizard to install you

HTTF server(s) the application will use to applications. Make sure your applic

18. Click Manage Installed Applications under Applications.
A page with the installed applications displays:

€ [V51-ENU-0825 © Stopped Enabled
C lteldirEAR € Stopped Enabled
C lwilabxx123 © Stopped Enabled
| Tests2 € Stopped Enabled
|@'wﬂabxx © Stopped |Enabled

Start) (Pro art Unitistall) Updats] |Refresh)

H

Close

19. Click wflabxx radio button in the list of installed applications.

20. If the wflabxx application is disabled, click the Properties push button to
enable the application.

Application Properties @

Application name: wilabioz 2
Application enablement: | Enabla g' ]
Location:

3 t 8D ta/ W eb ASE/ASES/server linstalle dpps @

OK| Apply| Cancel |

21. Select Enabled from theApplication enablement list.
22. Click OK.
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Next you start the application with wflabxx in the enabled state:

Tests2 (O Stopped | Enabled
wilabmx € Stopped Enabled

Start Properties | Uninstall| Update | Refresh |
"

OF

EIE
i

23. C(lick wflabxx radio button.
24. Click Start.
Now you are ready to test your Web-enabled application.

Testing the Web application

To test the Web application:

1. Open the Internet Explorer and type Http://servername:port#b/wflabxx in the
Address field.

Note: This is the HTTP port name, most likely 80, not the application bootstrap
port.

Your application index.html page should open. If it does not, double-check the
URL and the port number. Also try restarting the HTTP server and the
application server. Refer to the Administrative Console Web site if you are
having problems starting and running the HTTP server or the WebSphere
Application Server. If you still encounter problems, there are troubleshooting
guides, FAQs, and newsgroups on the Web where you can find an explanation
of your situation with more detailed information.

Recap

Congratulations! You have completed this module. You should now understand
how to:

* Export files created by the WebFacing Tool to a remote WebSphere Application
Server

* Publish and deploy your application in a real production environment

As you can see with the IBM WebFacing Tool, you can quickly convert your DDS
display file source members so that the user interface of your iSeries programs can
run in a browser. When you convert your DDS display files, JSP files and Java
beans are generated for you that substitute for the DDS code and make Web access
possible.

In the WebFacing Project wizard, you can select one or more DDS source members
to convert, and select a Web look and feel from one of several predefined styles, or
you can design your own Web style for use with your applications. The tool
creates three JSP and XML files for your record formats. The XML files hold the
data for the record format, or control its appearance or other characteristics, and
the JSP handles displaying the Web version of the screen, prompting for data, and
handling input errors. The wizard generates an application home page to launch
the Web-enabled version of your program.

When your invoke a converted application from the browser, the WebFacing server
on the iSeries server starts the server program. The server intercepts all calls to
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READ, WRITE, and EXFMT operations to DSPFs, so that in many cases your
program (*PGM) can run without modifications, and without even detecting that it
is being accessed using WebFacing. You might need to make coding changes if
your application uses DDS keywords that are not supported by WebFacing, or if
you want to modify the DDS screens so that the conversion to Web format
produces a more attractive or consistent result.
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Appendix. Notices

Note to U.S. Government Users Restricted Rights — Use, duplication or disclosure
restricted by GSA ADP Schedule Contract with IBM Corp.

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

Lab Director

IBM Canada Ltd. Laboratory
8200 Warden Avenue
Markham, Ontario

Canada

L6G 1C7

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. 1992, 2004. All rights reserved.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Programming interface information

Programming interface information is intended to help you create application
software using this program.

General-use programming interfaces allow you to write application software that
obtain the services of this program’s tools.
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However, this information may also contain diagnosis, modification, and tuning
information. Diagnosis, modification and tuning information is provided to help
you debug your application software.

Warning: Do not use this diagnosis, modification, and tuning information as a
programming interface because it is subject to change.

Trademarks

CUA

IBM
iSeries
0S/400
RPG/400
VisualAge
WebSphere

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

ActiveX, Microsoft, SourceSafe, Visual C++, Visual SourceSafe, Windows, Windows
NT®, Win32, Win32s and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

UNIX® is a registered trademark of The Open Group.

Other company, product, and service names may be trademarks or service marks
of others.
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